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Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also
describes potential hazards and associated warnings for the system and the precautions that should be taken to
minimize the hazards.

In addition to this section, refer to Glossary of Symbols for information about the symbols and conventions used
in the laboratory environment, on the system, and in this documentation. Refer to the Site Planning Guide
for site requirements, including AC mains supply, source exhaust, ventilation, compressed air, nitrogen, and
roughing pump requirements.

General Safety Information
To prevent personal injury or system damage, read, understand, and obey all of the safety precautions and warnings
in this document, the manufacturer chemical safety data sheet (SDS), and product label information. These labels
are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and
safety (EHS) regulations. The information provided covers system-related safety information applicable to the
operation of the system. It does not cover every safety procedure that should be practised. Ultimately, the user
and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and
for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance
This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity
included with the system and the individual system components for dated references. Applicable labels have been
affixed to the system.

Australia and New Zealand
• Electromagnetic Compatibility (EMC): Radio Communications Act 1992 as implemented in these

standards:

• Electromagnetic Interference—AS/NZS CISPR 11/ EN 55011/ CISPR 11 (Class A). Refer to Electromagnetic
Interference.
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• Safety: AS/NZ 61010-1 and IEC 61010-2-061

Canada
• Electromagnetic Interference (EMI): CAN/CSA CISPR11. This ISM device complies with Canadian

ICES-001. Refer to Electromagnetic Interference.

• Safety:

• CAN/CSA C22.2 No. 61010-1

• CAN/CSA C22.2 No 61010-2-061

Europe
• Electromagnetic Compatibility (EMC): Electromagnetic Compatibility directive 2014/30/EU as

implemented in these standards:

• EN 61326-1

• EN 55011 (Class A)
Refer to Electromagnetic Compatibility.

• Safety: Low Voltage Directives 2014/35/EU as implemented in these standards:

• EN 61010-1

• EN 61010-2-061

• Waste Electrical and Electronic Equipment (WEEE): Waste Electrical and Electronic Equipment 2012/
96/EEC, as implemented in EN 40519. Refer to Waste Electrical and Electronic Equipment.

• Packaging and Packaging Waste (PPW): Packaging and Packaging Waste Directive 94/62/EC

• RoHS Restriction of Hazardous Substances: RoHS Directive 2011/65/EU

United States
• Radio Emissions Interference Regulations: 47 CFR 15, as implemented in FCC Part 15 (Class A)

• Safety: Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these standards:

• UL 61010-1

• IEC 61010-2-061
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International
• Electromagnetic Compatibility (EMC):

• IEC 61326-1

• IEC CISPR 11 (Class A)

• IEC 61000-3-2

• IEC 61000-3-3
Refer to Electromagnetic Compatibility.

• Safety:

• IEC 61010-1

• IEC 61010-2-061

Electrical Precautions

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be
removed.

• Follow required electrical safe work practices.

• Use cable management practices to control electrical cables. This will reduce the chance of a tripping hazard.

For information about system electrical specifications, refer to the Site Planning Guide.

AC Mains Supply
Connect the system to a compatible AC mains supply as instructed in this guide.

WARNING! Electrical Shock Hazard. Use only qualified personnel for the
installation of all of the electrical supplies and fixtures and make sure that
all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.
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WARNING! Electrical Shock Hazard. Use only the power cables supplied with
the system. Do not use power cables that are not properly rated for the
operation of this system.

An external line transformer is not needed for the mass spectrometer, optional bench, or roughing pump.

Protective Earth Conductor
The mains supply must include a correctly installed protective earth conductor. The protective earth conductor
must be installed or checked by a qualified electrician before the system is connected.

WARNING! Electrical Shock Hazard. Do not intentionally interrupt the
protective earth conductor. Any interruption of the protective earth conductor
creates an electrical shock hazard.

WARNING! Electrical Shock Hazard. Make sure that a protective earth
conductor (grounding cable) is connected between the sample loop and an
appropriate grounding point at the ion source. This supplementary grounding
will reinforce the safety configuration specified by SCIEX.

Chemical Precautions

WARNING!  Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Determine whether decontamination is required prior to cleaning or
maintenance. The customer must decontaminate the system prior to cleaning
or maintenance if radioactive materials, biological agents, or toxic chemicals
have been used with the system.

WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

WARNING! Biohazard, Toxic Chemical Hazard. Connect the drain tubing to
the mass spectrometer and the source exhaust drain bottle properly, to
prevent leaks.
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• Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to
the Safety Data Sheets for the health and safety precautions that must be followed with chemicals. SCIEX
Safety Data Sheets can be found at sciex.com/tech-regulatory.

• Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety
glasses, and a laboratory coat.

• Work in a well-ventilated area or fume hood.

• Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other
flammable solvents.

• Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for
handling and disposing of chemicals are not followed.

• Avoid skin contact with chemicals during cleaning and wash hands after use.

• Make sure that all exhaust hoses are connected properly and that all connections are functioning as designed.

• Collect all spent liquids and dispose of them as hazardous waste.

• Comply with all of the local regulations for the storage, handling, and disposal of biohazardous, toxic, or
radioactive materials.

• (Recommended) Use secondary containment trays beneath the roughing pump, the solvent bottles, and the
waste collection container to capture potential chemical spills.

System Safe Fluids
The following fluids can safely be used with the system. Refer to Required Materials for information about safe
cleaning solutions.

CAUTION: Potential System Damage. Do not use any other fluid until confirmation is
received from SCIEX that it does not present a hazard. This is not an exhaustive list.

• Organic Solvents

• MS-grade acetonitrile; up to 100%

• MS-grade methanol; up to 100%

• Isopropanol; up to 100%

• HPLC-grade or higher water; up to 100%

• Buffers

• Ammonium acetate; less than 1%

• Ammonium formate; less than 1%
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• Acids and Bases

• Formic acid; less than 1%

• Acetic acid; less than 1%

• Trifluoroacetic acid (TFA); less than 1%

• Heptafluorobutyric acid (HFBA); less than 1%

• Ammonia/ammonium hydroxide; less than 1%

Ventilation Precautions
The venting of fumes and disposal of waste must comply with all of the federal, state, provincial, and local health
and safety regulations. It is the responsibility of the customer to make sure that the air quality is maintained in
compliance with local health and safety regulations.

The source exhaust system and roughing pump must be vented to a dedicated laboratory fume hood or an external
exhaust system.

WARNING! Fire Hazard. Make sure that the source exhaust system is connected and
functioning to prevent flammable vapor from accumulating in the ion source.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Take care to vent exhaust gases to a dedicated laboratory fume hood or
exhaust system and make sure that the ventilation tubing is secured with
clamps. Make sure that the laboratory has appropriate air exchange for the
work performed.

WARNING!  Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Do not operate the mass spectrometer if the source exhaust drain and
roughing pump exhaust hoses are not properly connected to the laboratory
ventilation system. Perform a regular check of the exhaust tubing to make
sure that there are no leaks. The use of mass spectrometers without proper
system ventilation might constitute a health hazard and might result in serious
injury.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Use the ion source only if you have knowledge of and training in the proper
use, containment, and evacuation of toxic or injurious materials used with
the ion source.
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WARNING! Puncture Hazard, Ionizing Radiation Hazard, Biohazard, or Toxic
Chemical Hazard. Discontinue use of the ion source if the ion source window
is cracked or broken and then contact a SCIEX Field Service Employee (FSE).
Any toxic or injurious materials introduced into the equipment will be present
in the source exhaust output. Exhaust from equipment should be vented
from the room. Dispose of sharps following established laboratory safety
procedures.

Environmental Precautions
Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and
fixtures. Make sure that all of the installations comply with local bylaws and biohazard regulations. For information
about the required environmental conditions for the system, refer to the Site Planning Guide.

Allow access space around the equipment when setting up the system.

DANGER! Explosion Hazard. Do not operate the system in an environment containing
explosive gases. The system is not designed for operation in an explosive
environment.

WARNING! Biohazard. For biohazardous material use, always comply with local
regulations for hazard assessment, control, and handling. This system or any part
is not intended to act as a biological containment.

WARNING! Environmental Hazard. Follow established procedures for disposal
of biohazardous, toxic, radioactive, and electronic waste. The customer is
responsible for disposal of hazardous substances, including chemical, waste
oils and electrical components, in accordance with local laws and regulations.

CAUTION: Potential Mass Shift. Maintain a stable ambient temperature. If the temperature
changes by more than 2 °C per hour, then the resolution and mass calibration might be
affected.

Electromagnetic Environment

Electromagnetic Compatibility

Basic Electromagnetic Environment: Environment existing at locations characterized by being supplied
directly at low voltage from the public mains network.
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Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation of performance
and no loss of function during or after test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or more) during test
but shall operate as intended with some degradation of performance and functions self-recoverable after test.

Performance Criteria C (Criteria C): Equipment may experience loss of function (one or more) during test
but shall operate as intended with some degradation of performance and functions recoverable by operator after
test.

The equipment is intended for use in a basic electromagnetic environment.

Make sure that a compatible electromagnetic environment for the equipment can be maintained so that the device
will perform as intended. If the power supply line is subject to high electrical noise, then install a surge protector.

Electromagnetic Interference

Class A Equipment: Equipment which is suitable for use in all establishments other than domestic and those
directly connected to a low voltage power supply network which supplies buildings used for domestic purposes.
[Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part
15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the operator's manual, can cause harmful interference to radio
communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be
required to correct the interference, at your own expense. Changes or modifications not expressly approved by
the manufacturer could void your authority to operate the equipment.

Decommissioning and Disposal

WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local
environmental regulations.  Refer to Storage and Handling.

Note: SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE
to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.
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Waste Electrical and Electronic Equipment

Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of
waste, electrical, and electronic equipment (WEEE). To safely dispose of this equipment, contact a local Customer
Service office for complimentary equipment pick-up and recycling.

Qualified Personnel
Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing the system, the
Field Service Employee (FSE) uses the Customer Familiarization Checklist to orient the customer on system
operation, cleaning, and basic maintenance.

Only personnel qualified by the manufacturer shall maintain the equipment. A laboratory designate can be
familiarized with the Qualified Maintenance Person (QMP) procedures during the installation. A QMP is a person
who is suitably aware of the electrical and chemical risks associated with servicing laboratory equipment.

Laboratory Conditions

Operating Conditions
The system is designed to operate safely under these conditions:

• Indoors

• Altitude: Up to 2 000 m (6 560 feet) above sea level

• Ambient temperature: 5 °C (41 °F) to 40 °C (104 °F)

• Maximum relative humidity: 80% for temperatures up to 31 °C (88 °F), decreasing lineraly to 50% at 40 °C
(104 °F)

• Mains supply voltage fluctuations: ±10% of the nominal voltage

• Transient overvoltages: Up to the levels of Overvoltage Category II

• Temporary overvoltages on the mains supply

• Pollution degree: Pollution Degree 2

Performance Specifications
The system is designed to meet specifications under these conditions:

• An ambient temperature of 15 °C to 30 °C (59 °F to 86 °F)
Over time, the temperature must remain within a range of 4 °C (7.2 °F), with the rate of the change in
temperature not exceeding 2°C (3.6°F) per hour. Ambient temperature fluctuations exceeding the limits might
result in mass shifts in spectra.
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• Relative humidity from 20% to 80%, non-condensing

Equipment Use and Modification

WARNING! Personal Injury Hazard. Contact the SCIEX representative if product
installation, adjustment, or relocation is required.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be
removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts
not recommended by SCIEX or use of parts for any purpose other than their intended
purpose can put the user at risk of harm or negatively impact system performance.

Use the mass spectrometer and ion source indoors in a laboratory that complies with the environmental conditions
recommended in the Site Planning Guide for the mass spectrometer.

If the mass spectrometer and ion source are used in an environment or in a manner not prescribed by the
manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the mass spectrometer and ion source might cause personal injury and
equipment damage, and might void the warranty. Erroneous data might be generated if the mass spectrometer
and ion source is operated either above or below the recommended environmental conditions or operated with
unauthorized modifications. Contact an FSE for information on servicing the system.

Documentation Symbols and Conventions
The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action which leads to severe injury or death.

WARNING! Warning signifies an action that could cause personal injury if precautions
are not followed.
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CAUTION: Caution signifies an operation that could cause damage to the system or
corruption or loss of data if precautions are not followed.

Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text for a specific
need and provides shortcuts, but is not essential to the completion of a procedure.
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The system is designed for the qualitative and quantitative analysis of chemical species.

This section includes information about the mass spectrometer and the Analyst
®
 software. Refer to the ion source

Operator Guide for an overview of the ion source.

For information on the computer and software, refer to the Software Installation Guide for the Analyst
®

software.

WARNING! Lifting Hazard. Do not move the system without consulting a
Field Service Employee (FSE). Risk of personal injury or system damage. If the
system must be moved, then contact an FSE.

System Overview
This system is intended for the qualitative and quantitative analysis of chemical species.

The SCIEX Triple QuadTM 5500+ system is QTRAP
®
 Ready. Users can purchase a QTRAP

®
 License to access the

Linear Ion Trap features. For more information, visit the SCIEX website at sciex.com.

The system includes the following components:

• A mass spectrometer with a roughing pump and a source of compressed air and nitrogen

• Turbo VTM ion source that uses either the TurboIonSpray
®
 probe or the atmospheric pressure chemical ionization

(APCI) probe. Refer to the Turbo VTM Ion Source Operator Guide.

• SCIEX-supplied computer and monitor with the Analyst
®
 software for instrument optimization, acquisition

method development, processing, and data acquisition. For computer specifications and requirements, refer
to the Analyst

®
 Software Installation Guide.
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Hardware Overview

Figure 2-1 Front View

Refer to...DescriptionItem

Panel Symbols.Panel symbols1

Adjust the Integrated Syringe Pump PositionSyringe pump2

Turbo VTMIon Source Operator Guide, available from the
ion source documentation DVD, or from the SCIEX Web site, at
sciex.com

Ion source3

Plumb the Diverter Valve.Diverter valve4

Panel Symbols

Table 2-1 describes the mass spectrometer status LEDs.
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Table 2-1 Panel Symbols

DescriptionNameColorLED

Lit when the system is powered up.PowerGreen

Lit when the correct vacuum level has been
achieved. Flashing if the vacuum is not at the
correct level (during pump down and venting).

VacuumGreen

Lit when the system is in the Ready state. The
system must be in the Ready state to operate.

ReadyGreen

Flashing when the system is acquiring data.ScanningBlue

Lit when the system encounters a system fault.FaultRed

After the system is turned on, all of the LEDs illuminate. The power LED remains lit. The other LEDs flash for two
seconds and then turn off. The vacuum LED starts flashing. After the correct vacuum level is achieved this LED
remains lit.

Theory of Operation—Hardware
Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds, to quantify known
compounds, and to provide information about the structural and chemical properties of molecules.

The mass spectrometer has a series of quadrupole filters that transmit ions according to their mass-to-charge
(m/z) ratio. The first quadrupole in this series is the IonDriveTM QJet ion guide, located between the orifice plate
and the Q0 region. The IonDriveTM QJet ion guide does not filter ions, but focuses them before they enter the Q0
region. By prefocusing the larger ion flux created by the wider orifice, the IonDriveTM QJet ion guide increases
system sensitivity and improves the signal-to-noise ratio. In the Q0 region, the ions are again focused before
passing into the Q1 quadrupole.
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Figure 2-2 Ion Path

DescriptionItem

Orifice plate1

QJet ion guide2

Q0 region3

Q1 quadrupole4

Q2 collision cell5

Q3 quadrupole6

Detector7

The Q1 quadrupole is a filtering quadrupole that sorts the ions before they enter the Q2 collision cell. The Q2
collision cell is where the internal energy of an ion is increased through collisions with gas molecules to the point
that molecular bonds break, creating product ions. This technique allows users to design experiments that measure
the m/z of product ions to determine the composition of the parent ions.

After passing through the Q2 collision cell, the ions enter the Q3 quadrupole for additional filtering, and then they
enter the detector. In the detector, the ions create a current that is converted into a voltage pulse. The voltage
pulses leaving the detector are directly proportional to the quantity of ions entering the detector. The system
monitors these voltage pulses and then converts the information into a signal. The signal represents the ion
intensity for a particular m/z value and the system shows this information as a mass spectrum.

Note: Linear ion trap features are only available on QTRAP
®
 Enabled systems.

The linear ion trap (LIT) functionality provides a number of enhanced modes of operation. A common factor of the
enhanced modes is that ions are trapped in the Q3 quadrupole region and then scanned out to produce full
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spectrum data. Many spectra are rapidly collected in a short period of time and are significantly more intense than
spectra collected in a comparable standard quadrupole mode of operation.

During the collection phase, ions pass through the Q2 collision cell where the CAD gas focuses the ions into the
Q3 region. The Q3 quadrupole is operated with only the main RF voltage applied. Ions are prevented from passing
through the Q3 quadrupole and are reflected back by an exit lens to which a DC barrier voltage is applied. After
the fill time elapses (a time defined by the user, or determined by the Dynamic Fill Time feature), a DC barrier
voltage is applied to the Q3 entrance lens (IQ3). This confines the collected ions in the Q3 region and stops
additional ions from entering. The entrance and exit lens DC voltage barriers and the RF voltage applied to the
quadrupole rods confine the ions within the Q3 region.

During the scan out phase, the voltage on the exit lens and the auxiliary RF voltage are ramped simultaneously
with the main RF voltage for increased resolution and sensitivity as compared to quadrupole scan modes. An
auxiliary AC frequency is applied to the Q3 quadrupole. The main RF voltage amplitude is ramped from low to
high values, which sequentially brings masses into resonance with the auxiliary AC frequency. When ions are
brought into resonance with the AC frequency, they acquire enough axial velocity to overcome the exit lens barrier
and are axially ejected towards the mass spectrometer ion detector. Full spectra data can be acquired from the
ions collected in the Q3 region by rapidly scanning the main RF voltage.

Data Handling

The Analyst
®
 software requires a computer running the Windows 7 (32- or 64-bit) operating system or the Windows

10 (64-bit) operating system. The computer and the associated system software work with the system controller
and the associated firmware to control the system and data acquisition. During system operation, the acquired
data is sent to the Analyst

®
 software where it can be shown as either full mass spectra, intensity of single or

multiple ions over time, or total ion current over time.

Analyst
®
 Software Overview

The Analyst
®
 software works with the mass spectrometer and the liquid chromatography (LC) system and the

associated firmware to control the system and data acquisition. During system operation, the acquired data is
sent to the Analyst

®
 software where it can be shown as full mass spectra, intensity of single or multiple ions over

time, or total ion count over time.

Different Data Views

The following figures show examples of two types of data views: total ion chromatogram (TIC) and extracted ion
chromatogram (XIC).

TIC: The plot of the total ion current as a function of time.
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Figure 2-3 Example TIC

XIC: An ion chromatogram created by taking intensity values at a single, discrete mass value or a mass range,
from a series of mass spectral scans. It indicates the behavior of a given mass or mass range as a function of time.

Figure 2-4 Example XIC

System User GuideSCIEX Triple QuadTM 5500+ System
RUO-IDV-05-8450-A24 / 194

Principles of Operation



Parameters

The working parameters are the set of mass spectrometer parameters currently being used.

The compound parameters and source and gas parameters are stored with the method. The resolution and detector
parameters are mass spectrometer-dependent and are stored as instrument data. If the Tune and Calibrate mode
is used to create a method, then the working parameters can be optimized for best instrument performance.
Alternatively, ramp each parameter, one at a time, while cycling the experiment.

• Source and gas parameters: These parameters can change depending on the ion source used.

• Compound parameters: These parameters consist mostly of voltages in the ion path. Optimal values for
compound-dependent parameters vary depending on the compound being analyzed.

• Resolution parameters: These parameters affect the resolution and calibration.

• Detector parameters: These parameters affect the detector.

The parameters in the table apply to the ion source that comes with the system. For information regarding other
ion sources, refer to the Operator Guide that comes with the ion source. The following figure shows the location
of the parameters on the ion optics path.

Figure 2-5 Ion Optics Path and Parameters
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Scan TypeUseParameter
Type

ParameterLocation

AllThe IS parameter controls the voltage applied
to the electrode in the TurboIonSpray

®
 probe

that ionizes the sample in the ion source. The
parameter depends on the polarity and it affects
the spray stability and the sensitivity. The
parameter can be compound-dependent and
must be optimized for each compound.

Source and gasIonSpray
Voltage (IS)

1

AllThe NC parameter controls the current applied
to the corona discharge needle in the APCI
probe, used in the Turbo VTM ion source. The
discharge ionizes solvent molecules, which in
turn ionize the sample molecules.

Source and gasNebulizer
Current (NC)

1

AllFor the Turbo VTM ion source, the GS1 parameter
controls the nebulizer gas for both the
TurboIonSpray

®
 and APCI probes.

Source and gasIon Source Gas
1 (GS1)

1

AllFor the Turbo VTM ion source, the GS2 parameter
controls the heater gas for the TurboIonSpray

®

probe.

Source and gasIon Source Gas
2 (GS2)

1

AllThe TEM parameter controls the temperature
of the heater gas for the TurboIonSpray

®
 probe

or the temperature of the APCI probe.

Source and gasTemperature
(TEM)

1

AllThe CUR parameter controls the gas flow of the
Curtain GasTM interface. The Curtain GasTM

interface is located between the curtain plate
and the orifice. It prevents the contamination
of the ion optics.

Source and gasCurtain Gas
(CUR)

1

AllThe DP parameter controls the voltage on the
orifice, which controls the ability to decluster
ions between the orifice and the IonDriveTM QJet
ion guide. It is used to minimize the solvent
clusters that might remain on the sample ions
after they enter the vacuum chamber, and, if
required, to fragment ions. The higher the
voltage, the higher the energy imparted to the
ions. If the DP parameter is too high, then
unwanted fragmentation might occur.

Use the preset value and optimize for the
compound.

CompoundDeclustering
Potential (DP)

1
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Scan TypeUseParameter
Type

ParameterLocation

AllThe EP parameter controls the potential
difference between the voltage on Q0 and
ground. The entrance potential guides and
focuses the ions through the high-pressure on
the Q0 region.

Use the preset value.

CompoundEntrance
Potential (EP)

2

EMS, EMC,
EPI, ER, and
MS/MS/MS

The Q0 trapping parameter controls the storage
of ions in the Q0 region. It is used to increase
sensitivity and duty cycle by trapping ions in the
Q0 region while ions are being mass-selectively
ejected from the linear ion trap. Use a fixed fill
time with this parameter.

Either select or clear the feature as required by
the experiment.

We recommend using a fixed fill time of 20 ms
or greater.

CompoundQ0 Trapping2

Q3 MI, Q3 MS,
MRM, Prec,
NL, EMS, ER,
EPI, MS/MS/
MS, EMC, and
TDF

The CAD parameter controls the pressure of the
CAD gas in the collision cell during Q3, MS/MS,
and LIT scans. For Q3 scans, the collision gas
helps to focus the ions as they pass through the
Q2 collision cell. The preset value for the CAD
parameter is in Fixed mode. For MS/MS scan
types, the CAD gas helps to fragment the
precursor ions. When the precursor ions collide
with the collision gas, they dissociate to form
product ions. For LIT scan types, the collision
gas helps to focus and trap ions in the linear
ion trap.

Use the preset value and optimize for the
compound.

Source and gasCAD Gas3
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Scan TypeUseParameter
Type

ParameterLocation

EPI, MS/MS/
MS, MRM,
MS2, Prec, NL,
and LIT

The CE parameter controls the potential
difference between the Q0 region and the Q2
collision cell. It is used only in MS/MS scan
types. This parameter is the amount of energy
that the precursor ions receive as they are
accelerated into the Q2 collision cell, where they
collide with gas molecules and fragment.

Use the preset value and optimize for the
compound.

CompoundCollision
Energy (CE)

3

EPI and MS/
MS/MS

The CES parameter, in conjunction with the CE
parameter, determines which three discrete
collision energies are applied to the precursor
mass in an Enhanced Product Ion (EPI) or MS/
MS/MS (MS3)  scan when CES is used. When a
collision energy spread value is entered, CES is
automatically turned on.

Use the preset value and optimize for the
compound.

CompoundCollision
Energy Spread
(CES)

3

Q3, MRM,
MS2, Prec, NL

The CXP parameter is only used in Q3 and MS/
MS scan types. This parameter transmits the
ions into the Q3 quadrupole.

Use the preset value and optimize for the
compound.

CompoundCollision Cell
Exit Potential
(CXP)

3

EMS, EMC,
EPI, ER, and
MS/MS/MS

The Q3 Entry Barrier parameter is used to
transfer the ions from the Q2 collision cell into
the linear ion trap.

Use the preset value.

CompoundQ3 Entry
Barrier

4

EMCThe Q3 Empty Time parameter controls the
amount of time that elapses before
singly-charged ions are removed from the linear
ion trap.

Use the preset value.

CompoundQ3 Empty
Time

4

EMCThe MCS Barrier parameter controls the voltage
used to eliminate the singly-charged ions from
the linear ion trap.

Use the preset value.

CompoundMulti-Charge
Separation
(MCS) Barrier

5
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Scan TypeUseParameter
Type

ParameterLocation

MS/MS/MSThe MS/MS/MS Fragmentation Time parameter
controls the amount of time that the excitation
energy is applied. It is used in combination with
the excitation energy to fragment the isolated
second precursor ion.

Use the preset value.

CompoundMS/MS/MS
Fragmentation
Excitation
Time

5

EMS, EPI, ER,
and MS/MS/
MS

The Fixed LIT Fill Time parameter controls the
amount of time that the LIT fills with ions.

Use the preset value and adjust it to achieve
the desired signal response based on sample
concentration.

CompoundFixed LIT Fill
Time

6

EMS, EPI, ER,
and MS/MS/
MS

The DFT parameter dynamically calculates the
amount of time that ions are collected in the
linear ion trap based on the incoming ion signal.
When DFT is turned on, the signal is optimized
to either increase sensitivity or minimize
space-charging.

Either select or clear the feature based on the
experiment.

In the Tools > Settings > Method
Options dialog, the DFT settings are optimized
for the default scan rate. These settings are also
suitable for other LIT scan speeds.

CompoundDynamic Fill
Time (DFT)

6

AllThe CEM parameter controls the voltage applied
to the detector. The voltage controls the
detector response.

DetectorCEM7

Theory of Operation—Analyst
®
 Software

Quantitation

The goal of quantitation in LC-MS/MS is to accurately determine the concentration of a compound in an unknown
sample. In an MRM scan, the ability to define the precursor ion and characteristic product ion enables the creation
a pair that is highly specific of the analyte. The MRM transition (pair) coupled with the retention time associated
with the analyte during liquid chromatography provides the specificity required for quantitation.

Quantitation is accomplished through the use of validated MRM LC-MS/MS acquisition methods, acquisition of
calibration standard curves, and the subsequent integration of the peaks associated with the compounds of interest.
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The calibration curve relationship between signal response and concentration is used to determine the quantity
of a particular analyte in an unknown sample.

Integration

In LC-MS/MS data, integration refers to obtaining the area under a curve for the peak associated with a specific
compound. Through the development of a method which specifies the transitions, expected retention times,
internal standards, integration, and regression parameters, the software is able to automatically integrate peaks
for a given set of samples.

About Results Tables

Results tables summarize the calculated concentration of an analyte in each unknown sample based on the
calibration curve. Results tables also include the calibration curves as well as statistics for the results. The user
can customize the results tables and view the results tables in layouts.

The data from a results tables can be exported to a txt file for use in other applications, such as Microsoft Excel.
The user can also export data in the table or just the data in the visible columns.

Calibration Curves

A calibration curve, also know as a standard concentration curve, is a method for determining the concentration
of a substance in an unknown sample by comparing the unknown sample to a set of standard samples of known
concentration. The calibration curve is a plot of how the instrument responds (the analytical signal) to changes in
the concentration of the analyte (the substance to be measured). The operator prepares a series of standards
across a range of concentrations near the expected concentration of the analyte in the unknown sample.

Calibration standards are used to build calibration curves. Incorrect readings or missing readings on some of the
calibration samples might indicate issues with the analytical run. Follow acceptable methods found in literature
and regulatory agency guidances to create a calibration curve. Examples of good practice in the preparation of
calibration curves include:

• Preparing calibration standards in blank matrix in which the analyte is to be measured.

• Generating a calibration curve for each analyte to be measured.

• Making sure of the coverage of the expected concentration range of the analyte, including typical and atypical
specimens.

• Using six to eight standards to generate the curve.

This is not a comprehensive list and other guidances should be used in determining the best practice in developing
a calibration curve for the laboratory.

Note: In some analytical runs, single-point calibration standards are used. Single-point calibrations are performed
using a matrix blank sample and a single standard concentration. The relationship between instrument response
and analyte concentration is determined by the line created by these two points. Both the acquisition and
quantitation methods should be validated before being accepted for their intended use.
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Regression

The area of the analyte peaks in the calibration curve standards is plotted against the known concentrations.
Subsequently, a line is fitted to the points. This regression line is used to calculate the concentration of the unknown
samples.

• Linear (y = mx + b)

• Linear through Zero (y = mx)

• Quadratic (y = a2 + bx + c)

As well, it is possible to add different types of weighting for the regression, including:

• 1/x

• 1/x2

• 1/y

• 1/y2
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Table 3-1 Instrument Setup Workflow

What does it do?Find the
information in....

To do this...Step

Each hardware profile must include a mass
spectrometer and other devices, such as an LC
system. Only devices included in the active
hardware profile can be used when creating
acquisition methods.

Create a Hardware
Profile

Create a hardware
profile.

1

Using projects and subprojects facilitates data
management and makes comparison of results
easier.

Create Projects and
Subprojects

Create projects to
store data.

2

This is the process of optimizing the resolution
and mass spectrometer parameters, and
calibrating the mass spectrometer to obtain
the best sensitivity and performance from the
system.

Verify Instrument
Performance

Optimize the mass
spectrometer.

3

Table 3-2 Sample Acquisition Workflow

What does it do?Find the
information in....

To do this...Step

Using projects and subprojects facilitates data
management and makes comparison of results
easier.

Create Projects and
Subprojects

Create projects to
store data.

1

To analyze samples, create an acquisition
method for the mass spectrometer and any LC
devices. An acquisition method indicates which
peripheral devices to use, when to use them
to acquire data, and the associated parameters.

Acquisition MethodsCreate an acquisition
method.

2
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Table 3-2 Sample Acquisition Workflow (continued)

What does it do?Find the
information in....

To do this...Step

After creating an acquisition method, run
samples by creating an acquisition batch and
submitting the batch to the acquisition queue.

Add Sets and Samples
to a Batch and Submit
a Sample or Set of
Samples

Create and submit a
batch.

3

Running samples involves managing the
acquisition queue and monitoring instrument
and device status. To submit samples and
acquire data, use the Queue Manager. The
Queue Manager shows queue, batch, and
sample status, and facilitates management of
samples and batches in the queue.

Acquire DataRun samples to
acquire data.

4

In Explore mode, many tools are available for
viewing and processing the acquired data.
Graphs can be customized with peak labels
and captions, contour plots can be shown, and
spectra can be saved in the library.

Analyze and Explore
Data

Analyze data in
Explore mode.

—OR—

Step 6—Analyze
quantitative data.

5

Use the various quantitative method creation
tools in Quantitate mode to analyze the
acquired data and build a quantitative method
to generate a Results Table. Use the Results
Table to manually review all of the peaks for
each analyte and internal standard within a
batch and to view calibration curves, sample
statistics, and metric plots.

Analyze and Process
Quantitative Data

Analyze quantitative
data.

6
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Table 3-3 Example Routine Analysis Workflow

What does it do?Find the
information in....

To do this...Step

Each hardware profile must include a mass
spectrometer and other devices, such as an LC
system. Only devices included in the active
hardware profile can be used when creating
acquisition methods.

Create a Hardware
Profile

Activate a hardware
profile applicable to
the method.

1

Using projects and subprojects facilitates data
management and makes comparison of results
easier.

Create Projects and
Subprojects

Create projects to
store data.

2

After creating an acquisition method, run
samples by creating an acquisition batch and
submitting the batch to the acquisition queue.

Add Sets and Samples
to a Batch and Submit
a Sample or Set of
Samples

Create and submit a
batch.

3

Equilibrate the system prior to starting data
acquisition. A system that is not equilibrated
can result in poor data.

Equilibrate the SystemEquilibrate the system.4

Running samples involves managing the
acquisition queue and monitoring instrument
and device status. To submit samples and
acquire data, use the Queue Manager. The
Queue Manager shows queue, batch, and
sample status, and facilitates management of
samples and batches in the queue.

Acquire DataRun samples to
acquire data.

5

In Explore mode, many tools are available for
viewing and processing the acquired data.
Graphs can be customized with peak labels
and captions, contour plots can be shown, and
spectra can be saved in the library.

Analyze and Explore
Data

Analyze data in
Explore mode
(optional).

6

• For quantitative analysis using the MultiQuantTM software follow steps 7 to 8. The MultiQuantTM software is
recommended for larger data sets.

• For quantitative analysis using the Analyst
®
 software follow steps 9 to 10a

• For qualitative analysis using the Analyst
®
 software follow steps 9 to 10b.
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Table 3-3 Example Routine Analysis Workflow (continued)

What does it do?Find the
information in....

To do this...Step

Generate and use a Results Table to manually
review all of the peaks for each analyte and
internal standard within a batch and to view
calibration curves, sample statistics, and metric
plots.

MultiQuantTM

Software
Reference Guide:
Chapter 7, 8, 10, 11,
12, 13, 14

Analyze quantitative
data in the
MultiQuantTM

software.

7

Generate a report using the provided report
templates for the generated and reviewed
results.

MultiQuantTM

Software
Reference Guide:
Appendix C

Create a report in the
MultiQuantTM

software.

8

Generate a Results Table to manually review
all of the peaks for each analyte and internal
standard within a batch. For quantitative
analysis, also review calibration curves, sample
statistics, and metric plots.

Analyze and Process
Quantitative Data

Analyze qualitative (or
quantitative) data in
the Analyst

®
 software.

9

Generate a report using the provided report
templates for the generated and reviewed
results. For reports specific to qualitative
analysis, use the set of report templates labeled
with library searching.

Generate ReportsCreate a report in the
Analyst Reporter.

10a

Select the appropriate MS/MS spectra library
for the results and generate a report using the
provided report templates labeled as library
search for the generated and reviewed results.
For reports specific to qualitative analysis, use
the set of report templates labeled with library
search.

Generate ReportsSelect a library and
then create a report
using the Analyst
Reporter.

10b
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Table 3-4 Example Method Developer Workflow

What does it do?Find the
information in....

To do this...Step

Each hardware profile must include a mass
spectrometer and other devices, such as an LC
system. Only devices included in the active
hardware profile can be used when creating
acquisition methods.

Create a Hardware
Profile

Create a hardware
profile.

1

Using projects and subprojects facilitates data
management and makes comparison of results
easier.

Create Projects and
Subprojects

Create projects to
store data.

2

The software automatically optimizes the
compound and mass spectrometer parameters
for the compounds of interest.

Automatic
Optimization

Optimize the
compound
automatically

- Or - Step 4 Optimize
the compound
manually.

3

The user manually optimizes the compound
and mass spectrometer parameters for the
compounds of interest. Manual optimization
provides more experienced users with greater
control during the optimization process.

Operating Instructions
— Manual Compound
Optimization

Optimize the
compound manually.

4

To analyze samples, create an acquisition
method for the mass spectrometer and any LC
devices. An acquisition method indicates which
peripheral devices to use, when to use them
to acquire data, and the associated parameters.

Acquisition MethodsCreate an acquisition
method.

5

After creating an acquisition method, run
samples by creating an acquisition batch and
submitting the batch to the acquisition queue.

Add Sets and Samples
to a Batch and Submit
a Sample or Set of
Samples

Create and submit a
batch.

6

Equilibrate the system prior to starting data
acquisition. A system that is not equilibrated
can result in poor data.

Equilibrate the SystemEquilibrate the system.7
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Table 3-4 Example Method Developer Workflow (continued)

What does it do?Find the
information in....

To do this...Step

Running samples involves managing the
acquisition queue and monitoring instrument
and device status. To submit samples and
acquire data, use the Queue Manager. The
Queue Manager shows queue, batch, and
sample status, and facilitates management of
samples and batches in the queue.

Acquire DataRun samples to
acquire data.

8

In Explore mode, many tools are available for
viewing and processing the acquired data.
Graphs can be customized with peak labels
and captions, contour plots can be shown, and
spectra can be saved in the library.

Analyze and Explore
Data

Analyze data in
Explore mode
(optional).

9

• For quantitative analysis using the MultiQuantTM software follow steps 10 to 12. The MultiQuantTM software
is recommended for larger data sets.

• For quantitative analysis using the Analyst
®
 software follow steps 13 to 15.

• For qualitative analysis, contact Support.

Use the various quantitative method creation
tools in the software to analyze the acquired
data and build a quantitative method to
generate a Results Table.

MultiQuantTM

Software
Reference Guide:
Quantitation Method
Editor

Create a quantitative
method in the
MultiQuantTM

software.

10

Generate and use a Results Table to manually
review all of the peaks for each analyte and
internal standard within a batch and to view
calibration curves, sample statistics, and metric
plots.

MultiQuantTM

Software
Reference Guide:
Chapter 7, 8, 10, 11,
12, 13, 14

Analyze quantitative
data in MultiQuantTM

software.

11

Generate a report using the provided report
templates for the generated and reviewed
results.

MultiQuantTM

Software
Reference Guide:
Appendix C

Create a report in
MultiQuantTM

software.

12

Use the various quantitative method creation
tools in the software to analyze the acquired
data and build a quantitative method to
generate a Results Table.

MultiQuantTM

Software
Reference Guide:
Quantitation Method
Editor

Create a quantitative
method in the Analyst

®

software.

13
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Table 3-4 Example Method Developer Workflow (continued)

What does it do?Find the
information in....

To do this...Step

Generate a Results Table to manually review
all of the peaks for each analyte and internal
standard within a batch. For quantitative
analysis, also review calibration curves, sample
statistics, and metric plots.

Analyze and Process
Quantitative Data

Analyze qualitative (or
quantitative) data in
Analyst

®
 software.

14

Generate a report using the provided report
templates for the generated and reviewed
results. For reports specific to qualitative
analysis, use the set of report templates labeled
with library searching.

Generate ReportsCreate a report in the
Analyst Reporter.

15
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WARNING! Personal Injury Hazard. Follow the instructions in the documentation
when using the system. The protection provided by the equipment might be impaired
if the equipment is used in a manner not specified by SCIEX.

Start Up the System

WARNING! Electrical Shock Hazard. Make sure that the system can be
disconnected from the mains supply outlet in an emergency. Do not block
the mains supply outlet.

WARNING! Lifting Hazard. Do not move the system without consulting a
Field Service Employee (FSE). Risk of personal injury or system damage. If the
system must be moved, then contact an FSE.

Note: Before operating the instrument, read the safety information in Operational Precautions and Limitations.

Prerequisites

• The site requirements specified in the Site Planning Guide are met. The Site Planning Guide includes
information on the mains supply and connections, compressed air, nitrogen, roughing pump, ventilation,
exhaust, and site clearance requirements. Contact us for a copy of the Site Planning Guide, if required.
For contact information, go to sciex.com/contact-us.

• The source exhaust gas, compressed air, and nitrogen gases are connected to the mass spectrometer.

• The 4 L source exhaust drain bottle is connected to the exhaust waste connection on the back of the mass
spectrometer and to the laboratory ventilation system.

• The source exhaust hoses are securely clamped at the mass spectrometer, drain bottle, and ventilation
connections.

• The mass spectrometer convenience switch is turned off and the mains supply cable is plugged into the mass
spectrometer.

• The mass spectrometer and roughing pump mains supply cables are plugged into the 200 VAC to 240 VAC
mains supply.
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1. Turn on the computer.

2. Open the Analyst
®
 software.

Reset the Mass Spectrometer

1. Stop any ongoing scans and then turn off sample flow to the mass spectrometer.

2. In the Analyst
®
 software, deactivate the hardware profile, if it is active.

3. Press and hold the Reset button for five seconds.

A click is heard when the relay activates. After approximately three minutes, the mass spectrometer reaches
operating pressure.

Shut Down and Vent the System
Some procedures require that the system be shut down. Others require that it also be vented. Follow these steps
to shut down and, if required, vent the system.

Note: If the input gas supply must be disconnected, then relieve the pressure in the gas lines before disconnecting
it.

Tip! If the mass spectrometer will not be used for a length of time, then leave it in Standby mode with the ion
source in place. If the mass spectrometer must be shut down, then follow these instructions. Do not turn off the
roughing pump until after the turbo pumps have spun down.

1. Complete or stop any ongoing scans.

CAUTION: Potential System Damage. Turn off the sample flow before shutting down
the system.

2. Turn off the sample flow to the system.

3. In the Analyst
®
 software, deactivate the hardware profile, if it is active.

4. Close the software.

5. (If required) Follow these steps to vent the system:
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Note: Vent the system before performing a full cleaning of the vacuum interface, before cleaning the Q0
region, and before replacing the roughing pump oil. For more information contact the Qualified Maintenance
Person (QMP) or FSE.

a. Press and hold the Vent button for three seconds.

The Vacuum LED begins flashing quickly (more quickly than during pump down). The turbo pump spins
down gradually.

b. Allow the system to vent for 15 minutes.

6. Turn off the mass spectrometer convenience switch.

7. Disconnect the mass spectrometer mains supply cable from the mains supply outlet.

8. (If venting the system) Disconnect the roughing pump mains supply cable from the mains supply outlet.

Adjust the Integrated Syringe Pump Position

WARNING! Puncture Hazard. Take care when handling the syringe. The tip
of the syringe is extremely sharp.

WARNING! Puncture Hazard. Make sure that the syringe is seated properly
in the syringe pump and that the automatic syringe pump stop is adjusted
properly to avoid damaging or breaking the glass syringe. If the syringe
breaks, follow established safety procedures for sharps disposal.

1. Press the Release button on the right side of the syringe pump to lower the base and then insert the syringe.
Refer to Figure 4-1.
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Figure 4-1 Lowering the Syringe

DescriptionItem

Syringe plunger1

Release button. Press to raise or lower the base.2

2. Make sure that the end of the syringe is flush against the base and that the shaft of the syringe rests in the
cutout.

3. Adjust the post so that it triggers the automatic syringe stop before the syringe plunger hits the bottom of the
glass syringe. Refer to Figure 4-2.
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Figure 4-2 Automatic Syringe Stop

DescriptionItem

Automatic syringe stop. After the post hits the automatic syringe stop, the syringe pump
stops.

1

Post. Adjust the height to prevent the syringe plunger from hitting the syringe during
sample infusion.

2

Post lock screw. Tighten the screw after the height of the post is adjusted.3

4. Turn the side screws as shown in Figure 4-3 to secure the syringe.
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Figure 4-3 Syringe Pump Screws

5. Make sure that the mass spectrometer and integrated syringe pump are activated in the software.

Note: For subsequent manual use, on the mass spectrometer, press the button on the right side of the
syringe pump to start the flow. Refer to Figure 4-4. The LED beside the button flashes when the syringe pump
is in use. The syringe pump flow can also be controlled automatically by the Analyst

®
 software.
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Figure 4-4 Syringe Pump LED

DescriptionItem

Syringe pump on and off button1

Syringe pump status LED2

6. In the Analyst
®
 software, on the Navigation bar, double-click Manual Tuning.

7. Click Start Syringe.

8. To stop the syringe pump, click Stop Syringe.

Plumb the Diverter Valve
The integrated diverter valve, which is located next to the ion source, can be plumbed in injector mode or diverter
mode. To configure the valve, access the Configuration tab and then make sure that the Use integrated
injector/diverter valve check box is selected. Refer to Add Devices to a Hardware Profile.

CAUTION:  Potential Wrong Result. Do not press the diverter valve button during a run.
Doing so might result in incorrect data.
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Plumb the Diverter Valve in Injector Mode
When the valve is in Position A, the sample flows through the external loop. When the valve switches to Position
B, the sample is injected.

• Plumb the valve for injector mode.

Figure 4-5 Diverter Valve—Injector Mode Position A

Figure 4-6 Diverter Valve—Injector Mode Position B
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DescriptionItem

Sample in1

Waste out2

Sample loop (ports 3 and 6)3

Mobile phase in4

To column (or to the mass spectrometer, if a column is not installed)5

Plumb the Diverter Valve in Diverter Mode
When the valve is in Position A, the flow goes to the mass spectrometer. When the valve switches to Position B,
the flow goes to waste.

• Plumb the valve for diverter mode.

Figure 4-7 Diverter Valve—Diverter Mode Position A
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Figure 4-8 Diverter Valve—Diverter Mode Position B

DescriptionItem

To mass spectrometer1

From column2

Waste out3
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Hardware Profiles
A hardware profile tells the software how the mass spectrometer and the devices are configured and connected
to the computer. Multiple hardware profiles can be set up, but only one profile can be active at any time.

When a hardware profile is created in the Hardware Configuration Editor, the peripheral devices must be configured
so that the software can communicate with them. Configuring the peripheral devices requires two procedures:
setting up the physical connections and configuring the software to communicate with the peripheral devices.
When the software is installed, the driver required for each peripheral device is also installed. After the peripheral
devices are physically connected to the computer, set up the appropriate configuration information.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that
all devices to be used in the method are included in the hardware profile, including the syringe pump. The devices
configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as
icons in the Acquisition method pane. Only peripheral devices included in the active hardware profile can be used
when creating acquisition methods.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that
all devices to be used in the method are included in the hardware profile. The devices configured in the active
hardware profile and selected in the Add/Remove Device Method dialog are shown as icons in the Acquisition
method pane. Only peripheral devices included in the active hardware profile can be used when creating acquisition
methods.

For information about setting up the physical connections to the devices, refer to the Peripheral Devices Setup
Guide. For a list of the supported devices, refer to the Software Installation Guide for the Analyst

®
 software.

Create a Hardware Profile
The user can create multiple hardware profiles, but only one profile can be active at any time.

1. On the Navigation bar, under Configure, double-click Hardware Configuration.
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Figure 5-1 Hardware Configuration Editor Dialog

2. In the Hardware Configuration Editor dialog, click New Profile.
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Figure 5-2 Create New Hardware Profile Dialog

3. Type a name in the Profile Name field.

4. Click Add Device.
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Figure 5-3 Available Devices Dialog

In the Available Devices dialog, in the Device Type field, Mass Spectrometer is the preset value.

5. In the Devices list, select the appropriate mass spectrometer and then click OK to return to the Create New
Hardware Profile dialog.

6. Click Setup Device.

The QTRAP
®
 License information is shown at the bottom of the dialog. If a license was purchased, then the

Linear Ion Trap features are enabled.
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Figure 5-4 Linear Ion Trap Features Enabled
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Figure 5-5 Linear Ion Trap Features Disabled

7. (Optional) To configure mass spectrometers that use the integrated syringe pump, on the Configuration
tab, select the Use integrated syringe pump check box.

8. (Optional) To configure the mass spectrometer for the diverter valve, on the Configuration tab, select Use
integrated injector/diverter valve.

9. (Optional) Select additional features on the Configuration and Communication tabs as required.

10. Click OK to return to the Create New Hardware Profile dialog.

11. Click Add Device and then add and set up each device that is used with the mass spectrometer. Refer to
Add Devices to a Hardware Profile.

12. Click OK in the Create New Hardware Profile dialog.

13. Click the hardware profile to be activated in the Hardware Configuration Editor.

14. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.

Tip! A hardware profile need not be deactivated before another is activated. Click a hardware profile and
then click Activate Profile. The other profile is deactivated automatically.
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15. Click Close.

Add Devices to a Hardware Profile
Devices must be configured to enable the software to communicate with them. When the software is installed,
the driver required for each device is also installed. After the devices are physically connected to the computer,
configure them.

Only the devices configured in the active hardware profile and selected in the Add/Remove Device Method dialog
are shown as icons in the Acquisition Method Browser pane.

1. Open the Hardware Configuration Editor.

2. In the Hardware Profiles list, deactivate the hardware profile.

3. Click Edit Profile.

4. Click Add Device.

Note:  Remember to add a mass spectrometer. For more information, refer to Create a Hardware Profile.

5. In the Available Devices dialog, in the Device Type list, select the device and then click OK.
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Figure 5-6 Available Devices Dialog

6. Click OK.

7. Select the device from the Devices list and then click OK.

8. Click Setup Device.

A dialog containing configuration values for the device opens.

9. (Optional) On the Communication tab, in the Alias field, type a name or other identifier for the device.

Note: For devices using serial communication, make sure that the serial port selected matches the serial
port to which the device is physically connected. When the serial expansion cable is used, the number selected
in the profile is the number on the cable plus two.

Note: The Alias field might also be referred to as the Name box and might be found on another tab under
Alias.

• If the device uses a Serial Port as a communication interface, then in the COM Port Number list,
select the COM port to which the device is connected.
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• If the device uses Ethernet as a communication interface, then type the IP Address assigned to the
device by the administrator or use the corresponding Host Name for the address.

• If the device uses GPIB Board as a communication interface, then do not change the settings for the GPIB
board.

The rest of the preset values for the device are probably appropriate. Do not change them. For information
about the Configuration and Communication tabs, refer to the Help.

10. To restore the device preset values, on the Communication tab, click Set Defaults.

11. To save the configuration, click OK.

12. Repeat step  4 to step  11 for each device.

13. Click OK in the Create New Hardware Profile dialog.

14. To activate the hardware profile, in the Hardware Configuration Editor, click the hardware profile.

15. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.
For more information, refer to Troubleshoot Hardware Profile Activation.

Tip! An active hardware profile does not have to be deactivated before another one is activated. Click an
inactive hardware profile and then click Activate Profile. The other profile is deactivated automatically.

16. Click Close.

Troubleshoot Hardware Profile Activation
If a hardware profile fails to become active, then a dialog opens indicating which device in the profile failed. A
device might fail to activate because of communications errors.

1. Read the error message generated. Depending on the message, there might be an issue with a device or how
the communication is set up.

2. Verify that the device has power and is turned on.

3. Verify that the COM port or IP address assigned to the device is correct.

Tip! On computers with two built-in serial ports, the first port on the serial port expansion card is usually
COM3, even though the cable indicates P1.

4. Verify that the communication settings for the device (for example, dip switch settings) are set correctly and
match the settings on the Communication tab.

5. Turn off the device.

6. Wait 10 seconds.
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7. Turn on the device.

Wait until all device power-up activities are complete before trying to activate the hardware profile again.
Some devices might require 30 seconds or more to complete the power-up activities.

8. Activate the hardware profile.

9. If the issue persists, then delete the failing profile and create a new one.

10. If the issue still persists, then contact technical support.

Projects and Subprojects
Before beginning an experiment, decide where to store the files related to the experiment. Use projects and
subprojects for each experiment to better manage data and compare results. For example, use subprojects to store
the results for specific dates.

Create Projects and Subprojects
To use a subproject structure within a project, create the subproject structure when the project is created.

1. Click Tools > Project > Create Project.

Figure 5-7 Create New Project/Subproject Dialog

Note: A new subproject cannot be created for a project that was not originally created with a subproject.

2. Type a project name in the Project name field.
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3. (Optional) To use subprojects, select the required folders and then use the arrow buttons to move them to the
Subproject folders list.

4. (If subprojects are used) In the Subproject name field, type a name for the first subproject or use the existing
date.

5. (Optional) To use this project and subproject folder organization for all new projects, select the Set
configuration as default for new projects check box.

All new projects are created with this folder configuration.

6. Click OK.

Create Subprojects
Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project tool bar, from the Project list, select the project.

2. Click Tools > Project > Create Subproject.

3. In the Subproject name box, type a name for the subproject or use the existing date.

4. Click OK.

Copy Subprojects
A subproject can be copied from another project that has existing subprojects. If the copied subprojects contain
folders that also exist in the project folder, then the software uses the project level folders.

1. Click Tools > Project > Copy Subproject.

The Copy Subproject dialog is shown.

2. Click Browse to navigate to the subproject source.

3. Click OK.

4. Select the subproject from the Source Subproject list.

5. Click Browse to navigate to the subproject destination.

6. Type the name in the Target Subproject field.

7. Click OK.

8. Do one of the following:

• To copy all folders and files from the Subproject Source into the Subproject Destination, select
the Copy Contents check box.
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• To copy only the folders in the same structure into the Subproject Destination, make sure that the
Copy Contents check box is cleared.

9. Click Copy.

Switch Between Projects and Subprojects

• On the software tool bar, from the project list, click the required project or subproject.

Figure 5-8 Project List

The project list in this figure shows the API Instrument, Default, and Example folders.

Installed Project Folders
Three project folders are installed with the software: API Instrument, Default, and Example.

API Instrument Folder

The API Instrument folder is unique and very important to the correct functioning of the mass spectrometer. The
API Instrument folder contains the information required for tuning and calibrating the mass spectrometer. This
information includes parameter settings files, reference files, instrument data files that contain calibration and
resolution information, and the acquisition methods used during automatic tuning. The API Instrument folder also
contains data files for manual tuning runs that were performed using the Start button rather than the Acquire
button. These data files are saved automatically in the API Instrument folder in the Tuning Cache folder and named
with the date and time they were created. The Tuning Cache folder is automatically cleared periodically.

Default Folder

The Default folder contains folders that are present in new projects and serves as a template for new projects.

Example Folder

The Example folder contains sample methods and data files. Users can practice working with the Explore or
Quantitate modes using the example data files. The example files are sorted into subfolders by mass spectrometer
type and application area.
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Back Up the API Instrument Folder
Back up the API Instrument folder regularly and after routine maintenance has been performed.

• Copy the API Instrument folder, paste it to a different location, preferably to another computer, and then
rename the folder. Use the date and a mass spectrometer reference if there is more than one mass spectrometer
when the folder is named. For example, API Instrument_instrument model3_010107

Recover the API Instrument Folder
Back up the API Instrument folder regularly and after routine maintenance has been performed. To recover
the API Instrument folder, do the following:

1. Rename the current API Instrument folder.

2. Copy the backup folder into the Projects folder.

3. Change the name of the backup folder to API Instrument.
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Run the Verify instrument performance option weekly or after the mass spectrometer is cleaned to confirm
that the system is working properly. In general, for triple quadrupole systems, calibration and resolution is
maintained for three to six months unless the system loses vacuum. For QTRAP

®
 systems, the resolution should

also be maintained for three to six months but the system should be calibrated approximately monthly. If the
system loses vacuum, then check the calibration and resolution before using the system. For more information
about tuning and calibration, refer to the Advanced User Guide and the Manual Tuning Tutorial.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

Prerequisites

• The spray is stable and the correct tuning solution is being used.

• A printer is configured.

Required Materials

• Tuning solutions that are supplied in the Standards Chemical Kit shipped with the system. If required, a new
kit can be ordered from SCIEX. Refer to Calibration Ions and Solutions on page 175.

• 5 mL, 1 mL, and 250 µL serial gas-tight syringes.

• Red PEEK sample tubing.

Verify Instrument Performance
The following procedure describes how to verify or adjust the performance of the mass spectrometer. For information
about using the other instrument performance options, refer to the Help. Refer to Calibration Ions and Solutions
on page 175.

Prerequisites

• The syringe pump is activated in the hardware profile. If the syringe pump is not activated, then edit the
hardware profile.Refer to Add Devices to a Hardware Profile.

• The API Instrument folder is selected.

1. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.
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2. Start the syringe pump, type 5 in the Duration field, and then run a calibration method. Confirm that the Total
Ion Chromatogram (TIC) is stable and that the peaks of interest are present in the spectrum.

Figure 6-1 Example of a Stable TIC and Peaks of Interest

3. On the Navigation bar, under Tune and Calibrate, double-click Instrument Optimization.

The Instrument Optimization dialog opens.
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4. Click Verify instrument performance.

5. Click Next.

6. Click Approved Tuning.

7. Click Next.

8. Select a Tuning Solution from the list.

Depending on the solution selected, different modes are available:
a. Click a polarity.

b. (If available) Click Q1 and Q3 in the Quad section.

c. (If available) Click the required scan speeds.

d. (If available) Click the scan speeds in the LIT section.

e. (If available) Click Excitation in the MS/MS/MS section

9. Click Next.

10. If the Select a mode page opens, then select Automatic.

11. Click Next.

12. Click GO.

The Verifying or Adjusting Performance dialog opens. After the process has completed, the Results Summary
opens. For more information, refer to the Help.

13. If applicable depending on the options selected. Change solutions for different scan types and polarities when
prompted.

About the Verifying or Adjusting Performance
Dialog
The top left corner shows the part of the instrument that is being tuned.

The Current Spectrum graph shows the spectrum of the current scan, the optimal scan selected by the software,
or the scan at the current parameter value when the software results are viewed in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the intensity versus voltage
curves of the parameters that are currently being optimized.

Results Summary
The Results Summary is a record of any instrument settings changes that were made by the Instrument Optimization
wizard.
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Figure 6-2 Results Summary

The Results Summary includes the location of data files and instrument settings backups, as well as step-by-step
changes and results during optimization.

The Results Summary also shows a verification report. This report contains a snapshot of the mass spectrum for
each relevant mass for the scan modes being verified. The spectrum is labeled with the target mass, where the
mass was found, mass shift, peak width, and peak intensity. The spectrum can be used as a visual record of peak
shape or scan mode performance. A summary table of results follows the spectra.

The Results Summary is automatically saved in the following path: <drive>:\Analyst Data\Projects\API
Instrument\Data\Instrument Optimization\yyyy-mm-dd\results.doc, where yyyy-mm-dd is the date on which the
report was created. Users can print the Results Summary or open a previously saved Results Summary.
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To tune instrument parameters for particular compounds the following steps are recommended. The following
equipment and solutions are suggested. Other solutions can be used depending on the system, peripheral devices,
and experiment.

This section describes how to:

• Automatically optimize for the analyte using the Compound Optimization wizard.

• Choose between infusion and flow injection analysis (FIA).

• Optimize parameters:

• If infusion analysis is chosen, then use an infusion method to optimize compound-dependent parameters.

• If FIA analysis is chosen, then use FIA to optimize compound- and ion source-dependent parameters.

This tutorial uses minoxidil, tolbutamide, reserpine, and rescinnamine as example compounds. Other available
compounds can be used, but the methods must be adjusted accordingly.

The user can also optimize compounds manually. Refer to Operating Instructions — Manual Compound Optimization.

Prerequisites

• The mass spectrometer is tuned and calibrated.

• (For FIA analysis) An acquisition method template is available.

• (For FIA analysis) An LC pump and an autosampler are connected and configured in the hardware profile.

• If the system has an integrated syringe pump, a syringe pump is configured in the hardware profile.

• All of the required peripheral devices, including the LC components, if needed, are configured in the hardware
profile.

Required Materials

• A syringe, preferably a 1.0 mL syringe.

• (For FIA analysis) Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.

Note: Users can choose a different mobile phase based on the experimental properties of the compound.

• LC pump and autosampler.

• (For FIA Analysis) Autosampler vials.
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Table 7-1 Compounds and Molecular Weights

m/zCompound

210.2Minoxidil

271.3Tolbutamide

609.4Reserpine

635.4Rescinnamine

Table 7-2 Estimates for Starting Concentrations

ConcentrationSystem

10 ng/mLSCIEX Triple QuadTM 5500+ system

About Automatic Optimization
Automatic optimization first checks for the presence of the compounds. The voltages of the various ion path
parameters are gradually increased or decreased to determine the maximum signal intensity (Q1 scan) for each
ion. A text file is generated and shown during the optimization process. This file records the various experiments
performed and the optimal values for each parameter. A file folder containing all the experiments performed is
also generated and can be found by opening the data file folder in Explore mode. For each experiment performed,
an acquisition method is also generated and saved in the Acquisition Method folder.

During the optimization process, select how the precursor ion and the corresponding product ions are to be chosen.

Types of Sample Introduction

Infusion

Infusion is the continuous flow of the sample at low flow rates into the ion source using a syringe pump. During
the infusion optimization process, the software can select precursor and product ions and optimize for declustering
potential, collision energy, and collision cell exit potential. The voltages of the ion path parameters are gradually
increased or decreased to determine the maximum signal intensity for the precursor and product ions.

Use infusion optimization to optimize compound-dependent parameters only at much lower flow rates than those
used during analysis.

FIA

FIA is the injection of a sample by the autosampler into the mass spectrometer using LC. During the FIA optimization
process, multiple sample injections are performed for various ion source- or compound-dependent parameter types
that are changed between injections. FIA compound optimization optimizes parameters by performing looped
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experiments in succession. One compound-dependent parameter is optimized first, followed by the next
compound-dependent parameter. FIA optimizes for ion source-dependent parameters by making one injection for
each value.

Compound parameters must be narrowed down using at least two more FIA cycles. Use FIA optimization to
optimize both compound-dependent and source-dependent parameters using LC at higher flow rates.

Table 7-3 Differences Between Sample Introduction Methods

Typical Flow Rate
Range

ParametersRequired DevicesMethod

5 µL/min to 25 µL/minCompound-dependentSyringe pumpInfusion

25 µL/min to 1000 µL/minSource- and compound-dependentLC pump and autosamplerFIA

During optimization, a text file is generated and then shown. This file records the various experiments performed
and the optimal values for each parameter. A file folder containing all the data files is also generated. For each
experiment performed, an acquisition method is also generated and saved in the Acquisition Methods folder.

Automatically Optimize for an Analyte Using
Infusion
In this section, users will perform automatic MS/MS optimization using infusion with a known precursor ion and
an unknown product ion.

Confirm the Presence of Compounds
Confirm the presence of compounds of interest before continuing with automatic optimization.

1. In the Analyst
®
 software, create a project.

2. Activate the hardware profile.

3. Infuse the compound in solution at a rate of 5 µL/min. to 10 µL/min.

4. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

5. In the method list field, click Syringe Pump Method.

6. On the Syringe Pump Method Properties tab, type the appropriate parameter values. Refer to Table 7-4.
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Table 7-4 Syringe Pump Method Properties Tab

Typical ValueParameter

Syringe dependent; 1.0 mL syringe is 4.610 mmSyringe Diameter

10Flow Rate

µL/min.Unit

Figure 7-1 Syringe Pump Method Properties Tab

7. Click Start Syringe Pump.

8. Click MS Method from the method list.

9. Click Start.

10. Wait until an even TIC is shown on the left and peaks are shown on the right and then click Stop.

11. Select the MCA check box.

12. Type 10 In the Cycles field.

13. Click Start.

When the ten scans are complete, the graph should show the masses of the four compounds as ions.

Note: The intensities of the compounds should be much higher than the smallest noise peaks but not so
high that any noise peaks are not seen. In the first case, the peak might not be a real compound. In the
second case, the concentration might be too high for the software to optimize properly.
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Figure 7-2 Compound Ions

Perform Automatic MS and MS/MS Optimization Using Infusion
with a Known Precursor Ion and an Unknown Product Ion
Automatic optimization for MS/MS analysis optimizes certain compound-dependent parameters for one or more
MRM transitions. The software finds the ion of interest and then optimizes the compound-dependent parameters
to get the maximum sensitivity for the compound. The software ramps CE and then selects the most intense
fragments that meet all of the product ion selection criteria.

If the initial Q1 scan signal is too high, then the software attempts to reduce the CEM to keep ions within the
detector range. If the signal is still too high after the CEM is reduced, then the process stops and an error message
is shown. Dilute the solution and then restart the optimization. Be sure to purge the infusion line. The parameters
from the last quantitative optimization are stored.

1. Make sure that the proper concentration of solution has been installed in the syringe pump, and that the syringe
pump has been started. If an integrated syringe pump is available and has been started, then the Syringe Pump
Status LED is flashing.

The syringe pump must be started in the Manual Tune window before compound optimization begins.

2. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.

3. On the Instrument Settings page, in the Inlet section, click Infusion.

4. Click MS/MS Analysis in the Mass Spectrometer section.
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5. Click Next.

6. On the Ions to use in MS/MS Analysis page, select the appropriate parameter values. Refer to Table 7-5.

Table 7-5 Example Parameters to use in MS/MS Analysis Page

ValueParameter

2.500MW Ion: Search Window

UnitResolution

PositivePolarity

Auto SelectProduct Ion

UnitResolution

Note: The optimization algorithm looks for the most intense peak in the specified search window. If the
most intense peak in that window is not the mass of interest, then the software optimizes on the wrong ion.

7. Click Criteria next to the Auto Select option.

8. In the Product Ion Auto Selection Criteria dialog, type the appropriate parameters. Refer to Table 7-6.
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Table 7-6 Example Product Ion Auto Selection Criteria Dialog Parameters

DescriptionValueParameter

The number of fragment peaks to be optimized. The algorithm
generates a product ion scan spectrum while ramping the CE in
MCA mode. In this example, the algorithm takes the three most
intense fragment ions from the spectrum and then continues the
MS/MS optimization on those fragments only.

For unknown compounds, select more peaks.

3From the Most
Intense (peaks)

The number of fragment ions per precursor ion (target compound)
to be automatically included in the acquisition method. The
specified number defines the number of MRM transitions to be
included for each target compound in the method. The order of
preference is based on the intensity of the fragment ion.

Two is a better starting value than one because typically two
product ions are required for quantitation. Start with three in
case there is a issue with one of the two best. Go back and the
third is already identified.

For unknown compounds, select more peaks for use in case of
interference.

2Build final method
using (most intense
peaks)

The Da value that defines the exclusion window around the
precursor ion so that fragment ions that fall within this window
are not selected for MRM optimization. For example, if the user
types ± 5 Da for a precursor ion that has an m/z of 500, then
any fragment ions within an m/z of 495 to 505 are excluded.
This prevents the precursor ion from being optimized as a product
ion.

20.000Exclude Product Ions
within ± (Da of
Precursor Ion m/z)

The lowest fragment mass to be considered for optimization. Use
this option to narrow or widen the window of fragment ions to
be considered from the precursor mass.

60.000Min. Mass for
Product Ion (Da)

Minimum number of counts for a product ion to be considered.100.000Threshold for
Product Ion (cps)

9. Click OK to save the changes to the selection criteria.

10. Click Next.

11. In the Target Components dialog, type the appropriate parameter values. Refer to Table 7-7.

Note: The compound name must be unique for each compound or transition.
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Table 7-7 Example Target Compounds Dialog Parameters

ValueFieldTarget
Compound

ReserpineCompound NameReserpine

609.3MW (Da)*

1No. Charges

MinoxidilCompound NameMinoxidil

210.2MW (Da)*

1No. Charges

TolbutamideCompound NameTolbutamide

271.3MW (Da)*

1No. Charges

RescinnamineCompound NameRescinnamine (IS)

635.4MW (Da)*

1No. Charges

*Type the exact ion mass.

12. Click Finish to begin the optimization process.

The screen shows two windows, a text file window and an acquisition window. The user might need to minimize
one of them to see the other. The experiment being run is shown on the top of the acquisition window. The
X-axis shows the parameter that is being optimized for each experiment. The text file window is updated as
results are generated.

After optimization is complete, an MRM acquisition file is created and named
[compound]_QOpt_FinalMRM_Pos.dam, where [compound] is the first compound in the Target Components
page.

Review the Optimization Results
At the end of the optimization, the optimized parameters are saved in an acquisition method. All dam and wiff
files generated in the optimization process are saved in the Acquisition Methods folder and in a subfolder in the
Data folder, respectively, in the project. The name of the subfolder is generated using the name of the compound
and the date.

1. After completing the optimization, print the text file containing the optimized parameters for each compound.

2. Click File > Open and then select the Reserpine_QOpt_FinalMRM.POS.dam file.
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3. Compare the values in the text file to those in the dam file.

4. Inspect the contents of the following folders:

• Data: Look through all of the runs executed during optimization. Compare a wiff file with the optimized
value in the method or printed parameters.

• Acquisition Method: Reserpine_QOpt_FinalMRM.POS.dam file and other dam files created during
optimization.

• Log: Report file (rtf) shown during the optimization process.

Automatically Optimize for an Analyte Using FIA

Prerequisites

• Identify the ions for the compounds and save the basic acquisition method.

• Add an autosampler and LC pump to the basic acquisition method. Using FIA for optimization requires that
these devices be active in the hardware profile.

• Create an LC-MS/MS acquisition method based on the Reserpine_QOpt_FinalMRM.POS.dam file and then
name the new method FIA_AutoOpt_Tutorial.dam.

• Make sure that the selected project contains the acquisition method that is being used.

Note: Although FIA can be used to optimize compound-dependent parameters, this is typically not done because
of the number of cycles required to obtain the optimal parameter values.

1. Put a dilution of the four-compound mix in an autosampler.

Enough sample is required to review each variable of each parameter and have sample left over. For example,
for the temperature to run at 300 °C, 400 °C, and 500 °C, if the injection volume is 10 µL, then more than a
30 µL (3 × 10 µL injection) is required.

2. Confirm that LC Sync is selected in the method.

Note: In LC Sync mode, the mass spectrometer coordinates with the action of the LC system to make sure
that data is acquired properly.
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Figure 7-3 Acquisition Method with LC Sync Selected

3. Make sure that the ion source and gas parameters are set to reasonable levels to prevent the contamination
of the mass spectrometer while optimizing. For more information, refer to the ion source Operator Guide.

4. Set the horizontal micrometer to 5.

5. Set the vertical micrometer on the ion source for the flow rate. As a starting point, use the parameters in the
following table: For more information, refer to the ion source Operator Guide.

Table 7-8 Ion Source Vertical Parameters

Initial Vertical ParametersFlow rate

10 mm1 μL/min to 20 μL/min

5 mm20 μL/min to 250 μL/min

2 mm250 μL/min to 500 μL/min

0 mm500 + μL/min

6. Set the values for the HPLC system and use an autosampler injection volume of 10 µL. Use the same
concentration or lower as for the infusion experiment.

The LC pumps must be configured for an isocratic run with no column. The MS and LC times must be the same
to collect the proper data.

The flow rate and percent of mobile phases used should be based on the LC column used, the general
chromatography, and the approximate mobile phase concentration at which the compounds of interest elute.
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7. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.

8. On the Instrument Settings page, depending on the LC system being used, type the appropriate parameter
values. Refer to Table 7-9.

Table 7-9 Example Instrument Settings Parameters

ValueParameter

FIAInlet

FIA_AutoOpt_Tutorial.damDefault Acq. Method

Autosampler specificRack Code

Autosampler specificRack Position

10 µLInjection Volume

MS/MS AnalysisMass Spectrometer

9. Click Next.

10. Make sure that the Int. Std. check box is cleared.

Selecting the check box indicates which MRM corresponds to the internal standards. Internal standards are
not optimized during the optimization process.

11. In the Resolution section, select Unit in both the Q1 Resolution and Q3 Resolution fields.
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Figure 7-4 Q1 and Q3 Resolution Fields

12. Click Next.

13. On the FIA Source Parameters page, type numbers that are lower or higher than the original value as long as
they are still within specifications.

Be sure not to go too low with any of the settings to keep the system clean. Refer to Table 7-10 for parameters
that can be used as a starting point.

Tip! Type the values before selecting the check box.

Table 7-10 Example Parameters for FIA Source Parameters Page

Values for OptimizationSelect the Optimize Check Box?Parameter

20;40;55YesCurtain Gas

—NoCollision Gas
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Table 7-10 Example Parameters for FIA Source Parameters Page (continued)

Values for OptimizationSelect the Optimize Check Box?Parameter

1500;2000;3000;4000;5000YesIonSpray Voltage

300;400;500;600;700YesTemperature

40;50;60;70;80;90YesIon Source Gas 1

40;50;60;70;80;90YesIon Source Gas 2

—NoInterface Heater

14. Select 1 or 2 beside Replicate Injection for each Parameter.

The total number of injections and the total sample volume are calculated based on the specifications here.
Note the total sample volume needed. Sample volume might be high depending on how many variables for
each parameter are being optimized, as each variable is a separate method.

Figure 7-5 Example Replicate Injection for each Parameter Field

15. Click Next.
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16. On the FIA Compound Parameters page for each analyte, use the example parameter values provided as a
starting point. Refer to Table 7-11.

Note: The values in Table 7-11 are suggested values. For more information, refer to the Help.

Table 7-11 Example FIA Compound Parameters Page

Values for OptimizationSelect the Optimize Check Box?Parameter

60;80;100;120;200YesDeclustering
Potential

—NoEntrance Potential

20;30;40;50;70;80;100YesCollision Energy

2;4;6;8;10;12YesCollision Cell Exit
Potential

The total number of injections and dependent sample volume update automatically. In contrast to ion source
parameters, which require one injection per value per replicate, compound-dependent parameters only require
one injection per parameter. A looped experiment is performed for each parameter. The values are alternated
scan-by-scan within one injection.

Note: Do not enter too many values. Doing so will prevent proper evaluation of the parameter.

17. Using the Compound list, move to another compound and type the parameters to be optimized.

18. Repeat step  17 until all of the parameters for all of the compounds are provided.

19. Type 1.5 in the Mass Spec. Duration field.

Note: This value should be at least the required length of time for each injection.
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Figure 7-6 Example Mass Spec. Duration Field

20. Click Finish to begin the optimization process.

The software optimizes the specified ion source- and compound-dependent parameters to get the maximum
sensitivity for the MRM transition of the compound. As the software proceeds through the optimization, it
creates a Compound Optimization report.

21. To obtain optimized parameters, repeat this routine.

Note:  Typically, the ion source and gas parameters must be narrowed using one more FIA cycle.

22. Open the final optimized FIA method called *_FIA_sample_1.

Note: The software generates several acquisition methods.

23. Save this method using a simpler name.
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An acquisition method consists of experiments and periods. Use the Acquisition Method Editor to create a sequence
of periods and experiments for the instrument and devices.

We recommend that only users who are proficient in method development create or modify acquisition and
quantitation methods. Refer to the Laboratory Director’s Guide for more information about roles and security.

Create an Acquisition Method Using the Acquisition
Method Editor

Tip! If users are creating a new acquisition method file from an existing file, then some or all of the peripheral
device methods in the acquisition method might be used.

Only devices configured in the active hardware profile appear in the Acquisition method pane. Any devices added
to the hardware profile must also be added to existing acquisition methods. For more information about devices,
refer to the Peripheral Devices Setup Guide.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices is active.

2. On the Navigation bar, under Acquire, double-click Build Acquisition Method.

3. Select a Synchronization Mode on the Acquisition Method Properties tab.

4. (Optional) Select the Auto-Equilibration check box and then type the required equilibration time, in minutes.

5. Click the Mass Spec icon in the Acquisition method pane.

6. Select a Scan type on the MS tab.

7. Type values in the fields as required. Refer to Parameters.

8. On the Advanced MS tab, type values in the fields as required.

9. On the MS tab, click Edit Parameters.

10. On the Source/Gas tab, specify values in the fields as required.

11. On the Compound tab, specify values in the fields as required and then click OK.

12. Click a device icon and then select the parameters for the device.

13. Add any additional periods and experiments. Refer to Add an Experiment and Add a Period.

14. Click File > Save.

SCIEX Triple QuadTM 5500+ SystemSystem User Guide
81 / 194RUO-IDV-05-8450-A

8Acquisition Methods



Configure the Integrated Syringe Pump

1. Confirm that the integrated syringe pump is selected in the hardware device profile.

2. Click the Syringe Pump icon in the Acquisition method pane.

The Syringe Pump Method Properties tab opens in the Acquisition Method editor.

Figure 8-1 Syringe Pump Properties tab

3. Type the syringe diameter in the Syringe Diameter (mm) field.

4. Type the flow rate in the Flow Rate field.

5. Select the units of flow from the Unit list.

Add an Experiment

1. In the Acquisition method pane, on the period where the experiment is to be added, right-click and then click
Add experiment.
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Figure 8-2 Add Experiment

An experiment is added below the last experiment in the period.

Note: An experiment cannot be inserted between experiments, IDA criteria, or periods. Users can only add
an experiment at the end of the period.

2. In the MS tab, select the appropriate parameters.

Add a Period

• In the Acquisition method pane, right-click the Mass Spec icon, and then click Add period.

A period is added below the last period created.

Note: Users cannot use multiple periods in an IDA experiment.

Copy an Experiment into a Period

1. Open a multi-period method.

2. In the Acquisition method pane, press Ctrl, and then drag the experiment to the period.

The experiment is copied below the last experiment in the period.

Copy an Experiment within a Period
Use this procedure to add the same or similar experiments to a period if most or all of the parameters are the
same.

• Right-click the experiment and then click Copy this experiment.
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A copy of the experiment is added below the last experiment created. This is useful when the same or similar
experiments are added to an acquisition method.

Scan Techniques
MS: In MS scans, also referred to as single MS scans, ions are separated according to their mass-to-charge ratio
(m/z). A single MS scan might be used to determine the molecular weight of a compound. Single MS scans can
also be referred to as survey scans. MS scans do not provide any information about the chemical make-up of the
ions other than the mass. Perform MS/MS or MS/MS/MS scans to obtain more information about the ions.

MS/MS: MS/MS scans are used to determine a molecular species.

• For MS/MS scans in triple quadrupole systems, precursor ion fragmentation occurs in the collision cell.

• For MS/MS scans in QTRAP
®
 systems, precursor ion fragmentation can occur in the collision cell or the linear

ion trap.

If enough energy is used, then the precursor ion fragments to produce characteristic product ions.

MS/MS/MS: The linear ion trap (LIT) system MS/MS/MS scans go one step further than MS/MS scans. A fragment
that is produced in the collision cell is fragmented further in the linear ion trap to give more structural information
about the molecular ion.

Quadrupole-Mode  Scan Types
Triple quadrupole instruments have high-sensitivity Multiple Reaction Monitoring (MRM) capabilities required for
quantitation experiments. In addition, they have highly specific scan types, such as precursor ion and neutral loss
scans, which allow a more advanced search to be performed on the components of the samples.

Q1 MS (Q1): A full scan type using the first quadrupole (Q1). The ion intensity is returned for every mass in the
scan range.

Q1 Multiple Ions (Q1 MI): A zero-width scan type using the Q1 quadrupole. The ion intensity is returned for
the specified masses only.

Q3 MS (Q3): A full scan type using the third quadrupole (Q3). The ion intensity is returned for every mass in the
scan range.

Q3 Multiple Ions (Q3 MI): A zero-width scan type using the Q3 quadrupole. The ion intensity is returned for
the specified masses only.

MRM (MRM): An MS/MS scan in which a user-selected ion is passed through the Q1 quadrupole and then
fragmented in the Q2 collision cell. The Q3 quadrupole then selects the fragment ion that enters the detector. This
scan mode is used primarily for quantitation.

Product Ion (MS2): An MS/MS full scan where the Q1 quadrupole is fixed to transmit a specific precursor ion
and the Q3 quadrupole scans a defined mass range. Used to identify all of the products of a particular precursor
ion.
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Precursor Ion (Prec): An MS/MS scan where the Q3 quadrupole is fixed at a specified mass-to-charge ratio to
transmit a specific product ion and the Q1 quadrupole scans a mass range. Used to confirm the presence of a
precursor ion or, more commonly, to identify compounds sharing a common product ion.

Neutral Loss (NL): An MS/MS scan where both the Q1 quadrupole and the Q3 quadrupole scan a mass range,
a fixed mass apart. A response is observed if the ion chosen by the Q1 quadrupole fragments by losing the neutral
loss (the fixed mass) specified. Used to confirm the presence of a precursor ion or, more commonly, to identify
compounds sharing a common neutral loss.

LIT-Mode Scan Types

Note: Linear ion trap features are only available on QTRAP
®
-enabled systems.

The LIT-mode scans use the Q3 quadrupole as a linear ion trap. Ions are trapped and stored in the Q3 quadrupole
before being scanned out, giving increased sensitivity. In addition, MS/MS/MS analysis can be performed in the
linear ion trap, providing more information about the sample. LIT-mode scan types are typically used for qualitative
measurements.

Enhanced MS (EMS): Ions are scanned in the Q1 quadrupole to the linear ion trap where they are collected.
These ions are scanned out of the Q3 quadrupole to produce single MS type spectra.

Enhanced Multi-Charge (EMC): This scan type is similar to the EMS scan except that before ions are scanned
out of the linear ion trap, there is a delay period during which low-charge state ions (primarily singly-charged ions)
are allowed to preferentially escape from the linear ion trap. When the retained ions are scanned out, the
multiply-charged ion population dominates the resulting spectrum.

Enhanced Product Ion (EPI): This scan type is used to obtain a high quality MS/MS spectrum on a specific
ion. The fragmentation is done in the Q2 collision cell and thus provides the information-rich MS/MS spectrum
typical of collisionally activated dissociation (CAD) fragmentation. In this scan mode, the precursor ion to be
fragmented is first selected in the Q1 quadrupole with a mass window that is 1 Da to 4 Da wide, filtering out all
other ions. The precursor ion is fragmented by CAD gas in the Q2 collision cell. The fragment ions generated are
captured in the linear ion trap and then scanned out at one of three scan speeds, depending on the required
fragment ion resolution.

For IDA experiments, the Product Of field is set to 30 Da by default, and this value should not be changed.

Enhanced Resolution (ER): This scan type is similar to the EMS scan except that a small 30 Da mass around
the precursor mass is scanned out of the linear ion trap at the slowest scan rate to produce a narrow window of
the best-resolved spectra.

MS/MS/MS (MS3): A precursor ion is selected by the Q1 quadrupole and fragmented with collisionally activated
dissociation in the Q2 collision cell. The resulting product ions are all transmitted to the linear ion trap, where a
single product ion is then isolated. The isolated ion is further fragmented in the linear ion trap, and the resulting
product ions are scanned out of the trap at one of three scan speeds. As with any in-trap Collision Induced
Dissociation (CID) technique, there is a low mass cut-off for the second MS/MS step due to the condition that the
lowest mass fragment and precursor must be simultaneously stable in the trap. For QTRAP

®
 systems, this results

in the loss of ions lower than 28 percent of the mass of the precursor ion during MS3 experiments. This phenomenon
is often referred to as the one-third cut-off rule.
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About Spectral Data Acquisition
Spectral data can be acquired in one of the modes described in Table 8-1.

Table 8-1 Spectral Data

DescriptionMode

The preset value is 0.1 Da. Profile data is the data generated by the mass
spectrometer and corresponds to the intensity recorded at a series of evenly
spaced discrete mass values. For example, for a mass range from 100 Da to
200 Da and a step size of 0.1 Da, the mass spectrometer scans 99.95 to 100.05
(recorded as value 100), 100.05 to 101.15 (recorded as value 101)…199.95
to 200.05 (recorded as value 200).

Profile

The preset value is 1.0 Da. Peak Hopping is a mode of operating a mass
spectrometer in which large steps (approximately 1 Da) are made. It has the
advantage of speed (fewer data steps are made) but with the loss of peak
shape information.

Peak Hopping

The mass spectrometer scans as in Profile mode, but creates a centroid of the
data, replacing found peaks with the intensity-weighted center of gravity for
each peak. Centroid data has the advantage of significantly reducing file size.
The disadvantage is that peak shape information is lost and if data has been
collected as a centroid then it cannot be altered. We recommend the use of
profile mode and centroiding of the data post-acquisition.

Centroid
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CAUTION: Potential System Damage. If the HPLC system connected to the mass spectrometer
are not controlled by the software, then do not leave the mass spectrometer unattended
while in operation. The liquid stream from the HPLC system can flood the ion source when
the mass spectrometer goes into Standby mode.

Set Queue Options
The queue goes one-by-one through the list, acquiring each sample with the selected acquisition method. After
all of the samples have been acquired, the queue stops and the mass spectrometer goes into Standby mode. In
Standby mode, the LC pumps and some instrument voltages are turned off.

The user can change the length of time the queue runs after the last acquisition has finished, before the Analyst
®

software puts the mass spectrometer into Standby mode. For information about the other fields in the Queue
Options dialog, refer to the Help.

1. On the Navigation bar, click Configure.

2. Click Tools > Settings > Queue Options.

Figure 9-1 Queue Options Dialog
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3. In the Max. Num. Waiting Samples field, set the maximum number of samples to a value that is greater
than the number of samples that will be submitted to the queue

4. In the Max. Idle Time field, type the length of time the queue will wait after acquisition is completed before
going to Standby mode. The preset value is 60 minutes.

If gas cylinders are used, then adjust this time to make sure that the gas in the cylinders is not depleted.

If an LC method is used, then before the run is started, make sure that there is enough solvent in the reservoirs
for all of the sample runs at the primary flow rate and the maximum idle time.

5. Select the Leave Mass Spec on in Standby check box to keep the mass spectrometer running after
analysis has been completed. This feature allows the heaters and gases to continue running, even after devices
have entered Idle state, so that the ion source and entrance to the mass spectrometer are kept free of
contaminants.

6. Select the Fail Whole Batch in Case of Missing Vial check box to fail the entire batch when a missing
vial is encountered. If this option is not selected, then only the current sample will fail and the queue will
continue to the next sample.

Create and Submit a Batch
Use this workflow to create a batch. In this example, use the MRM scan type that was created previously. Go
through the workflow twice more for practice, once using the Q1MS method and the second time using the Q1MI
method.

Add Sets and Samples to a Batch
A set can consist of a single sample or multiple samples.

Note: For more information about adding quantitation information to a batch, refer to the Advanced User
Guide.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.
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Figure 9-2 Batch Editor Dialog

2. In the Sample tab, in the Set list, type a name.

3. Click Add Set.

4. Click Add Samples to add samples to the new set.

Figure 9-3 Add Sample Dialog
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5. In the Sample name section, in the Prefix field, type a name for the samples in this set.

6. To add incremental numbering to the end of the sample name, select the Sample number check box.

7. If the Sample number check box is selected, then in the Number of digits field, type the number of
digits to include in the sample name.

For example, if 3 is typed, then the sample names would be samplename001, samplename002, and
samplename003.

8. In the Data file section, in the Prefix field, type a name for the data file that will store the sample information.

9. Select the Set name check box to use the set name as part of the data file name.

10. Select the Auto Increment check box to increment the data file names automatically.

Note: The data for each sample can be stored in the same or a separate data file. The names of the data
file will have numerical suffixes starting from 1.

11. Type a name in the Sub Folder field.

The folder is stored in the Data folder for the current project. If the Sub Folder field is left blank, then the
data file is stored in the Data folder and a subfolder is not created.

12. In the New samples section, in the Number field, type the number of new samples to add.

13. Click OK.

The sample table fills with the sample names and data file names.

Tip! Fill Down and Auto Increment options are available in the right-click menu after a single column
heading or several rows in a column are selected.

14. On the Sample tab, in the Acquisition section, select a method from the list.

Depending on how the system is set up, specific information for the autosampler must be entered. Even if the
injection volume is set in the method, the user can change the injection volume for one or more samples by
changing the value in the injection volume column.

Note: To use different methods for some of the samples in this set, select the Use Multiple Methods
check box. The Acquisition Method column is shown in the Sample table. Select the acquisition method
for each sample in this column.

15. To change the injection volumes from the volumes listed in the method, in the Inj. Volume (µL) column,
type the injection volume for each sample.

16. To set sample locations, do one of the following:
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• Set Sample Locations in the Batch Editor

• Select Vial Positions Using the Locations Tab (Optional)

17. (Optional) To define quantitation details prior to submitting the batch, refer to Set Quantitation Details in the
Batch Editor (Optional).

18. Click the Submit tab.

Note: The order of samples can be edited before the samples are submitted to the queue. To change the
order of samples, on the Submit tab, double-click any of the numbers at the far left of the table (a very
faint square box is shown), and then drag them to the new location.

19. If the Submit Status section contains a message about the status of the batch, then do one of the following:

• If the message indicates that the batch is ready for submission, then proceed to step  20.

• If the message indicates that the batch is not ready for submission, then make the changes as indicated by
the message.

20. After confirming that all of the batch information is correct, click Submit.

The batch is submitted to the queue and can be viewed in the Queue Manager.

21. Save the file.

Equilibrate the System
Equilibrate the system before submitting a batch. Equilibration warms up and prepares the mass spectrometer for
the next sample or batch.

1. Click .

The Equilibrate dialog opens.

2. Select the acquisition method used for the submitted batch.

3. Type the equilibration time in the Time (min) field, in minutes.

4. Select OK. The system starts the equilibration.

After the equilibration is completed, the system will change to Ready status.
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Tip! If the equilibration does not finish as expected, or if the system status does not change to Ready after
the equilibration finishes, then make sure that

• The activated hardware profile is appropriate for the acquisition method.

• The HPLC system is turned on.

• The HPLC system has correctly established communication with the software.

Submit a Sample or Set of Samples

Note: Run the sample again in the event of an abnormal termination during sample acquisition. If the abnormal
termination is caused by a power failure, then the temperature of the autosampler tray is not maintained and
sample integrity might be compromised.

1. Select one sample or a set of samples.

2. Click the Submit tab in the Batch Editor.

3. If the Submit Status section contains a message about the status of the batch, then do one of the following:

• If the message indicates that the batch is ready for submission, then proceed to the next step.

• If the message indicates that the batch is not ready for submission, then make the changes as indicated by
the message.

4. Click Submit.

Change Sample Order
The order of the samples can be edited before the samples are submitted to the Queue.

• On the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is
visible), and then drag them to the new location.

Acquire Data
The system must not be in Tune and Calibrate mode when sample acquisition is started. Also, if the system has
been previously run that day and has not yet been set to Standby mode, then sample acquisition will start
automatically.

1. Make sure that the column oven temperature is reached.
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2. Make sure that the  icon is not pressed in.

3. On the Navigation bar, click Acquire.

4. Click View > Sample Queue.

The Queue Manager opens with all submitted samples.

Figure 9-4 Queue Manager

DescriptionItem

The Reserve Instrument for Tuning icon should not be pressed in.1

Queue status should be in Ready mode.2

Queue Server should be in Normal. Refer to Queue States.3

5. Click Acquire > Start Sample.

Set Sample Locations in the Batch Editor
If an autosampler is used in the acquisition method, then the vial positions of the samples must be defined in the
acquisition batch. Define the location in the Sample tab or in the Locations tab. For more information about creating
batches, refer to Add Sets and Samples to a Batch.

1. In the Sample tab, from the Set list, select the set.

2. For each sample in the set, do the following if applicable:

• In the Rack Code column, select the rack type.

• In the Rack Position column, select the position of the rack in the autosampler.

• In the Plate Code column, select the plate type.

• In the Plate Position column, select the position of the plate on the rack.

• In the Vial Position column, type the position of the vial in the plate or tray.

3. Save the file.
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Select Vial Positions Using the Locations Tab
(Optional)

1. Click the Locations tab in the Batch Editor.

2. Select the set from the Set list.

3. Select the autosampler from the Autosampler list.

4. In the space associated with the rack, right-click and then select the rack type.

The plates or trays are shown in the rack.

5. Double-click in the white space labeled rack type. A visual sample rack layout is shown.

The appropriate number of rack spaces for the autosampler is shown in the graphic rack view.

6. Double-click one of the rectangles.

The circles depicting the wells or vials for the plate or tray are shown.

Tip! To see the corresponding vial number in the graphical representation, move the cursor over the sample
position. Use this information to confirm that the vial positions in the software match the vial positions in
the autosampler.

Figure 9-5 Locations Tab

Note: Depending on the autosampler being used, it might not be necessary to type details in additional
columns.

7. To select whether samples are marked by row or column, click the Row/Column selection selector button.

If the button shows a red horizontal line, then the Batch Editor marks the samples by row. If the button shows
a red vertical line, then the Batch Editor marks the samples by column.
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8. Click the sample wells or vials in the order to be analyzed.

Tip! Click a selected well or vial again to clear it.

Tip! To fill in the samples automatically, press the Shift key while clicking the first and last vial within a
set. To perform multiple injections from the same vial, press the Ctrl key while clicking the vial location. The
red circle changes to a green circle.

Set Quantitation Details in the Batch Editor
(Optional)
If a quantitation method is used with a batch and if the user does not want to select quantitation details after
acquisition, then the quantitation details (sample type, sample concentration) must be defined before the batch
is submitted.

The appropriate Internal Standard and Standard columns are shown in the Quantitation tab according to the
quantitation method selected in the Sample tab.

1. With a batch file open in the Batch Editor window, click the Quantitation tab.

2. Select the set containing the samples.

3. Select a Quant Type for all the samples from the list in the cell.

4. If applicable, type the analyte concentration in the Analyte column.

5. If applicable, type the internal standard concentration in the Internal Standard column.

6. Repeat this procedure for each set in the batch.

Stop Sample Acquisition
When a sample acquisition is stopped, the current scan finishes before the acquisition is stopped.

1. In the Queue Manager, click the sample in the queue after the point where acquisition should stop.

2. On the Navigation bar, click Acquire.

3. Click Acquire > Stop Sample.

The queue stops after the current scan in the selected sample is complete. The sample status in the Queue
Manager (Local) window changes to Terminated, and all other samples following in the queue are
Waiting.

4. To continue processing the batch, click Acquire > Start Sample.
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Import Batch Files
Users can import a text file containing batch information instead of creating a batch in the Batch Editor. If all the
sample details are in a spreadsheet, then it is faster to rearrange and import the data in the spreadsheet than to
manually type the data into the Batch Editor.

Before importing batch information from a text file, make sure that the data in the file is organized and formatted
correctly. In particular, the column headings in the spreadsheet must match the Batch Editor column headings. To
make sure that the text file includes the proper headings, create a batch using the Batch Editor, export it as a text
file, type the appropriate values in a spreadsheet editor, and then import the file back into the Batch Editor.

For examples of correctly formatted files, refer to the Batch folder in the Example project.

The information in a batch file can also be exported for use with other applications, such as Microsoft Excel,
Microsoft Access, and certain LIMS (Laboratory Information Management System) software.

Build a Batch as a Text File

Prerequisites

Make sure that the active hardware profile includes all of the devices to be used to acquire the samples.

To make sure that the text file includes the proper headings, create a batch using the Batch Editor, export it as a
text file, type the appropriate values in a spreadsheet editor, and then import the file back into the Batch Editor.
Users can export a batch only if it contains at least one set with at least one sample. The saved text file can be
used again later as a template.

1. In the Batch Editor, create a single-set, single-sample batch.

2. Click File > Export.

The Save As dialog opens.

3. Type a name for the text file in the File name field and then click Save.

4. Open the text file in a spreadsheet program such as Excel.

5. Type, or copy and paste, the details for the samples: one sample per row, with the details under the appropriate
headings.

Note: Do not delete any of the columns. The columns in the spreadsheet must match the columns in the
Batch Editor.

6. Save the modified text file as a .txt or .csv file and then close the spreadsheet program.

The text file is now ready to be imported into the Batch Editor.
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Import a Batch from a Text File

1. In the Batch Editor, on the Sample tab, right-click, and then click Import From > File.

The Open dialog opens.

2. Click the required text file and then click Open.

If an autosampler is used, then the Select Autosampler dialog opens.

Note: If the saved text file is not visible in the Files of type list, then select Microsoft Text Driver
(*.txt; *.csv). Files with the extension .txt are shown in the field.

3. In the autosampler list, select the autosampler and then click OK.

The sample table fills with the details from the text file.

4. Submit the batch.

Batch Editor Right-click Menu
Right-click in the Batch Editor table to access the options.

Figure 9-6 Batch Right-Click Menu
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FunctionMenu

Opens a batch file.Open

Imports a file.Import From

Saves the batch with a different name.Save As Batch

Saves the batch as a template.Save As a Template

Hides or shows a column.Hide/Show Column

Saves the batch column settings.Save Column Settings

Adds a custom column.Add Custom Column

Deletes a custom column.Delete Custom
Column

Copies the same data into the selected cells.Fill Down

Automatically increments data into the selected cells.AutoIncrement

Deletes the selected row.Delete Samples

Selects an autosampler.Select Autosampler

Queue States and Device Status
The Queue Manager shows queue, batch, and sample status. Detailed information about a particular sample
in the queue can also be viewed.

Tip! Click  to view the queue.

Queue States
The current state of the queue is indicated in the Queue Server.

Figure 9-7 Queue Server Indicator Showing Normal Mode
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Figure 9-8 Queue Server Indicator Showing Tune Mode

The first icon indicates the queue state. The second icon indicates whether the queue is in Tune mode (for tuning)
or Normal mode (for running samples). Table 9-1 describes the icons and queue states.

Table 9-1 Queue States

DefinitionStateIcons

The hardware profile is deactivated and the queue is not
accepting any sample submissions.

Not Ready

The hardware profile has been activated, but all devices are
idle. Pumps are not running and gases are turned off.

Stand By

The mass spectrometer and devices are equilibrating, columns
are being conditioned, the autosampler needle is being washed,
and column ovens are reaching temperature. The duration of
equilibration is selected by the operator. From this state, the
system can go to the Ready state.

Warming Up

The system is ready to start running samples and the devices
have been equilibrated and are ready to run. In this state, the
queue can receive samples and will run after samples are
submitted.

Ready

The system will automatically begin acquisition when the next
sample is submitted.

Waiting

The method is being downloaded to each device and device
equilibration is occurring. This state occurs before the acquisition
of each sample in a batch.

PreRun
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Table 9-1 Queue States (continued)

DefinitionStateIcons

The method is running and data acquisition is occuring.Acquiring

The system has been paused during acquisition.Paused

View Instrument and Device Status Icons
Icons representing the mass spectrometer and each device in the active hardware configuration are shown on the
status bar in the bottom right corner of the window. The user can view the detailed status of an LC pump to
determine whether the LC pump pressure is appropriate or view the detailed status of the mass spectrometer to
confirm the temperature of the ion source.

Note: For each status, the background color can be red. A red background indicates that the device encountered
an error while in that state.

• On the status bar, double-click the icon for the device or mass spectrometer.

The Instrument Status dialog opens.

Table 9-2 Instrument and Device Status Icons

DescriptionBackground
Color

IconStatus

The device is not running. If the background color is
yellow, then the device should be equilibrated before
it is ready to run. If the background color is green, the
device is ready to run.

Green or yellowIdle

The device is equilibrating.Green or yellowEquilibrating

The device is waiting for a command from the software
or another device, or for some action by the operator.

GreenWaiting

The device is running a batch.GreenRunning
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Table 9-2 Instrument and Device Status Icons (continued)

DescriptionBackground
Color

IconStatus

The device is aborting a run.GreenAborting

A method is being transferred to the device.GreenDownloading

The device is not running, but is ready to run.GreenReady

The device has encountered an error that should be
investigated.

RedError

Queue Right-click Menu
Right-click in the Queue table to access the options.

Figure 9-9 Queue Manager Right-Click Menu

FunctionMenu

Opens the Sample Details dialog.Sample Details

Acquires a sample again.Reacquire

Inserts a pause, in seconds, between two samples.Insert Pause

Deletes either the batch or the selected samples.Delete
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FunctionMenu

Moves the batch within the queue.Move Batch

Sorts on the preselected column.Sort

Changes the column settings.Column Settings
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This section describes how to use the Analyst
®
 software to analyze and process quantitative data. Data can also

be processed using the MultiQuantTM software. We suggest that the MultiQuantTM software is used to quantitate
data. Refer to the documentation that comes with the MultiQuantTM software.

Use the sample files found in the Example folder to learn how to select samples for quantitation, how to select
preset queries and create table-specific queries, and how to analyze the acquired data. For more information about
the following topics, refer to the Advanced User Guide.

• Metric Plots

• Layout of a Results Table

Quantitative Analysis
Quantitative analysis is used to find the concentration of a specific substance in a sample. By analyzing an unknown
sample and comparing it to other samples containing the same substance with known concentrations (standards),
the software can calculate the concentration of the unknown sample. The process involves creating a calibration
curve using the standards and then calculating the concentration for the unknown sample. The calculated
concentrations of each sample are then available in a Results Table.

Quantitation Methods
A quantitation method is a set of parameters used to generate peaks in a sample. The quantitation method can
include parameters used to locate and integrate peaks, generate standard curves, and calculate unknown
concentrations. A previously saved quantitation method can be selected from the Quantitation menu in the batch.
The user can create a quantitation method before data acquisition and then apply the method to the quantitative
data automatically after the batch is complete. Alternatively, a quantitation method can be created and applied
post-acquisition.

Three tools can be used to create a quantitation method: the Quantitation Wizard, the Build Quantitation Method,
and Quick Quant.

Quantitation Wizard

With the Quantitation Wizard, a Results Table is generated at the same time as the quantitation method.
Alternatively, an existing quantitation method can be used to quantitate different sets of data.
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Build Quantitation Method

The Build Quantitation Method does not generate a quantitation Results Table although the method can
subsequently be used in the Quantitation Wizard to create a Results Table. The Build Quantitation Method can
also be used to change existing quantitation methods. This is the most flexible way of creating a quantitation
method. Refer to Create a Method Using the Quantitation Method Editor.

Quick Quant

Quick Quant is not recommended for quantitation of results.

Quick Quant is part of the Batch Editor. Use Quick Quant to add compound concentrations prior to data acquisition.
Because a sample has not been acquired, a representative sample cannot be selected nor can peaks be reviewed.
With this process, only the method components are defined.

To use a previously saved quantitation method, select it from the Quantitation menu in the batch. For instructions
on creating a batch, refer to Create and Submit a Batch.

About Results Tables
Results tables summarize the calculated concentration of an analyte in each unknown sample based on the
calibration curve. Results tables also include the calibration curves as well as statistics for the results. The user
can customize the results tables and view the results tables in layouts.

The data from a results tables can be exported to a txt file for use in other applications, such as Microsoft Excel.
The user can also export data in the table or just the data in the visible columns.

Quantitation Methods and Results Tables
For the following procedures, use the sample data that is installed in Example folder. The Triple Quad folder
contains the data files, Mix_Batch_1 and Mix_Batch_2. These sample files are used to demonstrate the usefulness
of metric plots to isolate problematic samples. The ions scanned were reserpine (609.3/195.0), minoxidil
(210.2/164.2), tolbutamide (271.1/91.1) and rescinnamine (635.3/221.2), which is the internal standard.
Mix_Batch_1 contains no errors in terms of sample preparation, whereas Mix_Batch_2 contains a QC sample
where the internal standard was added twice (sample QC2).

Create a Method Using the Quantitation Method Editor

Prerequisites

• Select the project that contains the data to be quantified.

• Switch Between Projects and Subprojects

1. Make sure that the Example folder is selected.
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2. On the Navigation bar, under Quantitate, double-click Build Quantitation Method.

The Select Sample dialog opens.

3. Double-click the Triple Quad folder in the Data Files list.

4. Select Mix_Batch_2. wiff.

The samples in the selected data file are shown in the Samples list.

Note: If the Compound ID field was populated for the samples and internal standards in the acquisition
method, then in the Internal Standards table, when a value is selected in the Q1/Q3 field, the Name
field is automatically populated.

5. Select a sample that provides a detectable signal to select integration parameters that fit the entire batch and
then click OK.

6. In the Internal Standards table, in the Name column, select rescinnamine. In Q1/Q3 column, select
635.3/221.2.

7. In the Analytes table, do the following:

a. In the Name column, select minoxidol for the Q1/Q3 column masses of 210.2/164.188, tolbutamide
for 271.3/91.146, and reserpine for 609.4/195.039.

b. In the Internal Standard column, from the list, select the rescinnamine as internal standard to be
associated with each analyte.

c. Delete 635.4/221.185 from the Q1/Q3 column in the Analytes table.

Note: If the Compound ID field was populated for the samples and internal standards in the acquisition
method, then in the Analytes table, the Name field and Q1/Q3 field are populated.

8. Click the Integration tab.

The preset integration parameters are suitable for most peaks.

9. If the integration is not suitable, then change the algorithm. Refer to Manually Integrate Peaks.

10. Click the Show or Hide Parameters icon to show the additional integration algorithms.

11. Click the Calibration tab.

The preset parameters are suitable for these samples. User can change the fit, weighting, and regression
parameter depending on the specific applications.

12. Save the quantitation method.

The new method can be used when a batch is created in the Batch Editor or when the Quantitation Wizard is
used to generate a Results Table.
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Tip! The quantitation method can only be used in the current project unless it is copied to another project.
To do this, click Tools > Project > Copy Data. A new project must be created and selected to be available
for use.

Create a Results Table Using the Quantitation Wizard

Prerequisites

• Select the project that contains the data to be quantified.

• Switch Between Projects and Subprojects

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.

The Create Quantitation Set - Select Samples page opens.

2. Double-click the Triple Quad folder in the Available Data Files list.

3. Select Mix_batch_2. wiff.

4. Click Add All.

Note: We recommend that users do not process or report results from any sample for which acquisition was
abnormally or unexpectedly terminated.

5. Click Next.

The Create Quantitation Set - Select Settings & Query page opens.

6. Click Select Existing: Query in the Default Query section.

7. Select Accuracy 15% from the Query list.

Note: To create a query at the same time, refer to Create a Standard Query (Optional).

Note: It is the responsibility of the user to evaluate and validate the query to be used for specific applications.

8. Click Next.

The Create Quantitation Set - Select Method page opens.

9. Click Choose Existing Method.

10. Select PK Data_Mix.qmf from the Method list.
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11. Click Finish.

The Results Table opens.

Tip! To add or remove samples in the Results Table, click Tools > Results Table > Add/Remove
Samples.

12. Review the sample type, actual concentration, peak integration, calibration curves, statistics pane, metric plot
for the internal standard, and other information related to data quantitation.

13. Save the Results Table.

Note: We recommend that users do not change datafile (wiff) names if a Results Table includes samples
from that file.

Tip! Well-formatted reports can be created from a Results Table using the Reporter software. We recommend
that the user validate the results if a Reporter template that contains a query is used. Refer to Reporter
Software.

Create a Standard Query (Optional)
Advanced users can create a query and a standard query numerous ways. The following is one example. For more
information about creating queries, refer to the Help.

1. On the Navigation bar, under Quantitate, double-click Quantitation Wizard.

2. Select samples in the Create Quantitation Set - Select Samples page.

3. Click Next.

4. In the Select Settings & Query page, in the Default Query section, select Create New Standard Query.

5. Type a query name.
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Figure 10-1 Create Quantitation Set — Select Settings & Query Page

6. Click Next.
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Figure 10-2 Create Quantitation Set — Create Default Query Page

7. In the Maximum Allowed Accuracy Variation for QCs (%) table in the Max. Variation column,
type the maximum allowable percent of variation for each QC, for example 5 is ± 5%, in the same row as the
corresponding concentration. If the concentrations were not specified during acquisition, then they are not
shown here. In this case, type them in the Concentration column.

8. In the Maximum Allowed Accuracy Variation for Standards (%) table, in the Max. Variation
column, type the maximum allowable percent of variation for each standard, for example 10 is ±10%, in the
same row as the corresponding concentration. If the concentrations were not specified during acquisition, then
they are not shown here. Type the concentrations in the Concentration column.

9. Click Next.
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Figure 10-3 Create Quantitation Set — Select Method Page

10. Select or create a method.

11. Click Finish.

The query is applied as a standard query. The query results are shown as a Pass or Fail entry in the Standard
Query Status column of the Results Table.

Tip!  To return to the full view, right-click and then click Full.

Results Table Right-click Menu
Right-click in the Results Table to access the options shown in Table 10-1.

Table 10-1 Results Table Right-click Menu

FunctionMenu

Shows all the columns.Full

Shows specific columns.Summary

Shows a specific analyte.Analyte
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Table 10-1 Results Table Right-click Menu (continued)

FunctionMenu

Creates an analyte group.Analyte Group

Shows samples of a specific type or all samples.Sample Type

Adds a formula column.

We recommend that the user validate the results if a formula column is used.

Add Formula
Column

Edits or selects a table setting.Table Settings

Creates or selects a query.Query

Creates a sort or sorts by index.Sort

Creates a metric plot.Metric Plot

Deletes the active pane.Delete Pane

Copies the same data into the selected cells.Fill Down

Adds a custom column.Add Custom
Column

Deletes the selected custom column.Delete Custom
Column

Peak Review and Manual Integration of Peaks
Use peak review to survey the peaks that the software has identified and then redefine the peak or the start and
end points where required.

After identifying the analytes and internal standards that the software must find, the software searches for the
peaks in the samples. When the software identifies a peak, it shows the chromatograms for each analyte and
internal standard in the Create Quantitation Method: Define Integration page of the Standard Wizard or on the
Integration tab of the Full Method Editor. The user can confirm the peaks that are found or change the quantitation
method to better define the peaks. We recommend that users manually review all integration results.

Review Peaks
During peak review, the user might want to view a peak in its entirety or to examine the baseline to find out how
well the software found the start and end points of the peak. The automatic zooming feature can be used to do
either.

To help the software find a peak, define the exact start and end points of the peak and background manually.
These changes will apply only to that individual peak unless the global method is updated.
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Note: We recommend that manually integrated results be validated.

Tip! To review an individual peak, right-click on a point on the curve and then click Show Peak. The software
opens the Peak Review window with the selected peak.

1. Right-click in the Results Table and then click Analyte.

2. Select an analyte.

3. Click Tools > Peak Review > Pane.

The peaks are shown below the Results Table with only the peaks listed in the Results Table.

Figure 10-4 Peak Review

4. Right-click in the pane and then click Options.

5. In the Peak Review Options dialog, in the Appearance section, change Num. rows to 1 and Num.
columns to 2.

6. In the Automatic Zooming section, click Zoom Y axis to: 100% of largest peak to show the entire
peak.
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Figure 10-5 Peak Review Options Dialog

DefinitionItem

Number of rows1

Number of columns2

Zoom Y-axis to 100% of largest peak to show the entire peak3

7. Click OK.

8. To move through the peaks, click the right-pointing arrow. Refer to Figure 10-6 and Figure 10-7.

9. Go to the second injection of standard 3.

In this example, the peak can be integrated closer to the baseline by selecting the Specify Parameters
option.

Tip! To move to a specific peak in the Peak Review pane, select the corresponding row in the Results Table.
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Figure 10-6 Peak Review Pane
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Figure 10-7 Peak Review Pane

DefinitionItem

Arrows: Click to move through the peaks.1

Show or Hide Parameters: Click to show the integration parameters.2

Integration parameters: Click to change the parameters.3

Noise Percentage: Type a noise percent.4

Apply: Click to integrate the parameters.5

10. Click Show or Hide Parameters twice.

11. Click Specify Parameters - MQ III.

12. Change the Noise Percent value.

13. Click Apply.

The peak is integrated closer to the baseline.

14. If the change does not improve the peak integration, then adjust the Noise Percent parameter until the
optimal value is found.

Note: The Update Method function only updates the algorithm values for that specific analyte (or internal
standard) and not all analytes.

15. To update the algorithm for all peaks, right-click in the pane and then click Update Method.
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Figure 10-8 Update Method

Manually Integrate Peaks
Manually integrating peaks should be done last, to limit person-to-person variability. Manually integrate peaks
only if all the peaks have not been found after the algorithm parameters have been adjusted and updated. We
recommend that users validate the results to determine whether manual integration is acceptable for specific
applications.

Note: Peaks that are manually integrated, or where the algorithm was changed for only that peak, are identified
in the Record Modified column of the Results Table, as are peaks that have algorithm parameter changes for a
sample that are not applied to the entire analyte group.

1. In the Peak Review pane, click Manual Integration Mode.

Figure 10-9 Peak Review Pane: Manual Integration

2. Zoom in on the lower 10% of the peak.

System User GuideSCIEX Triple QuadTM 5500+ System
RUO-IDV-05-8450-A116 / 194

Analyze and Process Quantitative Data



Figure 10-10 Peak Review Pane: Zooming in on a Peak

3. Move the cross-hair to where the start of the peak is to be defined and then drag the cross-hair to where the
end of the peak is to be defined.

The software shades the area bounded by the base and sides of the peak. Peak parameters are gray as they
are no longer applicable because the peak was drawn manually.

4. Do one of the following:

• To make this change permanent, click Accept.

• To discard the changes, clear the Manual Integration check box.

Tip! If a peak was correct as originally selected, right-click the peak and then click Revert to Method.

Peak Review Right-Click Menu
Right-click in the Peak Review window or pane to access the options shown in Table 10-2.
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Table 10-2 Peak Review Right-click Menu

FunctionMenu

Opens the Peak Review Options dialog.Options

Opens the Sample Annotation dialog.Sample Annotation

Saves the selected peak as a text file.Save Active to Text
File

Goes to the first sample.Show First Page

Goes to the last sample.Show Last Page

Opens the slide show.Slide Show Peak
Review

Updates the algorithm for all peaks.Update Method

Selects a redefined peak based on the current quantitation method.Revert to Method

Deletes the active pane.Delete Pane

Calibration Curves
Use calibration curves to find the calculated concentration of samples, including quality control (QC) samples. QC
samples are added to a batch to estimate the data quality and accuracy of standards in the batch. QC samples
have known analyte concentrations but are treated as unknowns so that the measured concentrations can be
compared to the actual value.

The calibration curve is generated by plotting the concentration of the standard versus its area or height. If an
internal standard is used, then the ratio of the standard concentration or internal standard versus the ratio of the
standard peak height or area to the internal standard peak height or area is plotted. The area or height ratio of a
sample is then applied to this curve to find the concentration of the sample, as shown in the Results Table. A
regression equation is generated by this calibration curve according to the regression that was specified. The
regression equation is used to calculate the concentration of the unknown samples.

View Calibration Curves
The user can view the calibration curve and change the regression options in an open Results Table. If two or more
Results Tables are open, then the calibration curves can be overlaid. To overlay curves, make sure that the method
used to create the tables is the same.

Plot a calibration curve to see the curve used for regression. The Calculated Concentration field in the Results
Table reflects any changes resulting from the fit of the curve to the points of the standard.

System User GuideSCIEX Triple QuadTM 5500+ System
RUO-IDV-05-8450-A118 / 194

Analyze and Process Quantitative Data



Note: This option is available only when a Results Table is open in the workspace.

1. Open a Results Table.

2. Click Tools > Calibration > Pane.

The Calibration Curve pane containing the calibration curve opens.

Figure 10-11 Calibration Curve

3. If there is more than one analyte, then use the following steps to view the calibration curve for another analyte:

a. From the Analyte list, select an analyte.

b. If required, from the next list, select Area or Height.

4. To change the regression options for the calibration curve, do the following:

a. Click Regression.

Figure 10-12 Regression Options Dialog

b. Select Linear in the Fit list.

c. Select 1 / x in the Weighting list.

d. Click OK.
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The calibration curve opens. The user can review individual peaks on the curve or exclude points from the curve
to produce a better curve.

5. If required, repeat these steps to create a more appropriate curve.

6. To save the changes, click Accept.

Overlay Calibration Curves

Tip! To examine the curve for one table more closely, right-click the curve and then click Active Plot. Select
the curve to be plotted on top.

1. With two or more open Results Tables, view a calibration curve for one of the tables.

2. Right-click the calibration curve and then click Overlay.

Figure 10-13 Overlay Dialog

3. Select the tables to overlay with the current curve.

4. Click OK.

The software plots the curves for all selected tables on the same graph.

Calibration Curve Right-Click Menu
Right-click in the Calibration window or pane table to access the options shown in Table 10-3.

System User GuideSCIEX Triple QuadTM 5500+ System
RUO-IDV-05-8450-A120 / 194

Analyze and Process Quantitative Data



Table 10-3 Calibration Curve Right-click Menu

FunctionMenu

Right-click the point and then click Exclude to exclude the point from the curve.
Right-click the point and then click Include to include the point.

Exclude (Include)

Right-click a point and then click Exclude All Analytes to exclude all the
analytes from the curve. Right-click a point and then click Include All
Analytes to include the points.

Exclude All Analytes (Include
All Analytes)

Reviews an individual peak.Show Peak

Overlays two graphs.Overlay

Determines which plot is active.Active Plot

Shows the graph legend.Legend

Uses a log scale for the X-axis.Log Scale X Axis*

Uses a log scale for the Y-axis.Log Scale Y Axis*

Deletes the active pane.Delete Pane

Scales the graph to its original sizeHome Graph

* A log scale arranges the data points in a more manageable view so that the effect of all points can be monitored
simultaneously. For this view, select Log Scale Y Axis versus Log Scale X and not just the log of one axis.

Sample Statistics
Use the Statistics window to view the statistics samples, typically for standards and QCs (quality controls). The
data from each available batch in the Results Table opens in tabular form in the grid and a row of data is shown
for each standard or QC concentration.

View the Statistics for Standards and QCs
When more than one Results Table is open, statistical information about the standards and QCs for additional
batches in the Statistics window can be obtained. This facilitates comparison of results between batches and
identification of trends in the standards or QCs.

1. Open a Results Table.

2. Click Tools > Statistics.

3. Select Concentration from the Statistics Metric list.

4. Select an analyte in the Analyte Name field.
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5. Select Standard in the Sample Type field.

The results are shown.

6. Look at the %CV and Accuracy columns.

The %CV shows the coefficient of variance between the measurements of a single parameter, for example
the area. Accuracy shows how close the plotted point is to the interpolated value.

7. If required, select the Display Low/High values check box and then examine the Low, High values, and
Mean for each row in the grid. Each row represents standards that have the same concentration levels.

8. Select another analyte.

The results are shown on a per-analyte basis.

9. To check for Quality Control variations at the same concentration levels, select QC in the Sample Type
field.

Compare Results Between Batches
When more than one Results Table is shown, obtain statistical information about the standards and QCs for
additional batches in the Statistics window. Normally results are compared between batches to look for trends in
the standards or QCs or to verify that the method is valid.

For two or more open Results Tables, compare results in the Statistics window. Both sets of statistics are shown
in the Statistics window.

The number of analytes and the analyte names must be the same for the data to be combined in the Statistics
pane.

1. Open a Results Table.

2. Click Tools > Statistics.

3. Do one of the following:

• To arrange the results by Results Table, select Group By Batch in the Conc. as Rows list.

• To arrange the results in order of concentration, select Group By Concentration in the Conc. as
Rows list.

• To arrange the results in order of concentration without a row showing the statistics for each group or
batch, select Group By Concentration (no All) in the Conc. as Rows list.

The software sorts the results. At the end of each batch or group, one or two additional rows are shown: All
(statistics for all Results Tables in that group) and Average (statistics on the statistics for that batch or group).
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Use the sample files installed in the Example folder to learn how to view and analyze data using the most common
analysis and processing tools. For more information about the following topics, refer to the Advanced User
Guide:

• Labeling graphs

• Overlaying and summing spectra or chromatograms

• Performing background subtractions

• Smoothing algorithms

• Working with smoothed data

• Working with centroid data

• Working with contour plots

• Working with the fragment interpretation tool

• Working with library databases and library records

Open Data Files

Tip! To turn off the automatic update on the mass spectrum, right-click the mass spectrum and then click Show
Last Scan. If there is a check mark beside Show Last Scan, then the spectrum will update in real-time.

1. On the Navigation bar, under Explore, double-click Open Data File.

The Select Sample dialog is shown.

2. In the Data Files  list, navigate to the data file to open, select a sample, and then click OK.

The data acquired from the sample is shown. If data is still being acquired, then the mass spectrum, DAD/UV
trace, and TIC continue to update automatically.

Navigate Between Samples in a Data File

Note: If samples were saved in separate data files, then open each file individually.
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Table D-5 shows the navigation icons used in this procedure.

• Open a data file that contains multiple samples and then do one of the following:

• Click the icon with the arrow pointing to the right to skip to the next sample in the data file.

• Click the icon with the arrow curving to the right to skip to a non-sequential sample.

• In the Select Sample dialog, from the Sample list, select the sample to view.

• Click the icon with the arrow pointing to the left to go to the previous sample in the data file.

View Experimental Conditions
The experimental conditions used to collect data are stored in the data file with the results. The information
contains the details of the acquisition method used: the MS acquisition method (that is, the number of periods,
experiments, and cycles) including instrument parameters and the HPLC device method (LC pump flow rate). In
addition, it also contains the MS resolution and mass calibration tables used for the sample acquisition. Table
11-1 shows the software functionality available when the user views the file information.

Note: If data is acquired from more than one sample into the same wiff file, then the file information pane does
not refresh automatically while scrolling through the samples. Close the file information pane and then reopen
it to view the details for the next sample in the wiff file.

• Click Explore > Show > Show File Information.

The File Information pane opens below the graph.

Tip! To create an acquisition method from the File Information pane, right-click the File Information
pane and then click Save Acquisition Method.

Table 11-1 Right-click Menu for Show File Information Pane

FunctionMenu

Copies the selected data.Copy

Pastes data.Paste

Selects all the data in the pane.Select All

Saves data as an rtf file.Save To File

Changes the font.Font

Saves the acquisition method as a dam file.Save Acquisition Method
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Table 11-1 Right-click Menu for Show File Information Pane (continued)

FunctionMenu

Opens the Specify Compound Information dialog. Select the IDs and molecular
weights to be saved in the compound database.

Save Acquisition Method to
CompoundDB

Deletes the selected pane.Delete Pane

Show Data in Tables

1. Open a data file.

2. Click Explore > Show > Show List Data.

The data is shown in a pane below the graph.
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Figure 11-1 Peak List Tab
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Table 11-2 Right-click Menu for Spectral Peak List Tab

FunctionMenu

Opens the Select Columns for Peak List dialog.Column Options

Saves the data as a .txt file.Save As Text

Deletes the selected pane.Delete Pane

Table 11-3 Right-click Menu for Chromatographic Peak List Tab

FunctionMenu

Show the peaks in two colors in the graph.Show Peaks in Graph

Opens the Intelliquan dialog.IntelliQuan Parameters

Saves the data as a txt file.Save As Text

Deletes the selected pane.Delete Pane

Show ADC Data
ADC (analog-to-digital converter) data is acquired from a secondary detector (for example from a UV detector
through an ADC card), and is useful for comparison with mass spectrometer data. To have ADC data available,
acquire the data and the mass spectrometer data simultaneously and then save it in the same file.

1. Make sure that the Example folder is selected.

2. On the Navigation bar, under Explore, double-click Open Data File.

The Select Sample dialog opens.

3. In the Data Files field, double-click Devices and then click Adc16chan.wiff.

4. In the Samples list, select a sample, and then click OK.

5. Click Explore > Show > Show ADC Data.
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Figure 11-2 Select ADC Channel Dialog

6. In the Channel list, select a channel, and then click OK.

The ADC data is shown in a new pane beneath the active pane.

Show Basic Quantitative Data

1. Open a data file.

2. Click Explore > Show > Show List Data.

Figure 11-3 List Data
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3. In the Peak List tab, right-click and then select Show Peaks in Graph.

Peaks are shown in two colors.

4. To change the peak finding algorithm settings, right-click and then select either Analyst Classic Parameters
or Intelliquan Parameters, whichever is active.

5. (Optional) To remove the colored peaks, right-click in the Peak List tab and then clear Show Peaks in Graph.

Chromatograms
A chromatogram is a graphical view of the data obtained from the analysis of a sample. It plots the signal intensity
along an axis that shows either time or scan number. For more information about software functionality available
for chromatograms, refer to Table 11-6.

The software plots intensity, in counts per second (cps), on the Y-axis against time on the X-axis. Peaks above a
set threshold are labeled automatically. In the case of LC-MS, the chromatogram is often shown as a function of
time. Table 11-4 contains the a description of the types of chromatograms.

Refer to Table 11-8 for more information about using the available icons.

Table 11-4 Types of Chromatograms

PurposeTypes of
Chromatograms

A chromatographic view generated by plotting the intensity of all ions in a scan against
time or scan number.

When a data file is opened, it is preset to open as a TIC. If the experiment contains only
one scan, then it is shown as a spectrum.

If the MCA check box is selected during acquisition of the data file, then the data file
opens to the mass spectrum. If the MCA check box is not selected, then the data file opens
as the TIC.

TIC (Total Ion
Chromatogram)

An ion chromatogram created by taking intensity values at a single, discrete mass value,
or a mass range, from a series of mass spectral scans. It indicates the behavior of a given
mass, or mass range, as a function of time.

XIC (Extracted Ion
Chromatogram)

A chromatographic plot that shows the intensity of the most intense ion within a scan
versus time or scan number.

BPC (Base Peak
Chromatogram)

A chromatographic view created by summing all of the absorbance values in the acquired
wavelength range and then plotting the values against time. It consists of the summed
absorbances of all ions in a scan plotted against time in a chromatographic pane.

TWC (Total
Wavelength
Chromatogram)
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Table 11-4 Types of Chromatograms (continued)

PurposeTypes of
Chromatograms

A subset of TWC. An XWC shows the absorbance for a single wavelength or the sum of
the absorbance for a range of wavelengths.

XWC (Extracted
Wavelength
Chromatogram)

A UV detector that monitors the absorption spectrum of eluting compounds at one or
more wavelengths.

DAD (Diode Array
Detector)

Show TICs from a Spectrum
To see an example data file, make sure that the Example project is selected. Open the LIT folder, and then open
the Reserpine.wiff file.

• Click Explore > Show > Show TIC.

The TIC opens in a new pane.

Tip! Right-click inside a pane containing a spectrum and then click Show TIC.

Show a Spectrum from a TIC
A TIC is created by summing the intensity contributions of all ions from a series of mass scans. Use the TIC to view
an entire data set in a single pane. It consists of the summed intensities of all ions in a scan plotted against time
in a chromatographic pane. If the data contains results from multiple experiments, then the user can create
individual TICs for each experiment and another TIC that represents the sum of all experiments.

When a data file is opened, it is preset to appear as a TIC. However, if the experiment contains only one scan, it
is shown as a spectrum. If the user selects the MCA check box before acquiring the data file, then the data file
opens to the mass spectrum. If the MCA check box is not selected, then the data file opens with the TIC.

1. In a pane containing a TIC, select a range.

2. Click Explore > Show > Show Spectrum.

The spectrum opens in a new pane.

Tip! Double-click in the TIC pane at a particular time to show the spectrum.
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Figure 11-4 Example of a TIC

Generate XICs
XICs can be generated only from single-period, single-experiment chromatograms or spectra. To obtain an XIC
from multi-period or multi-experiment data, split the data into separate panes by clicking the triangle under the
X-axis. Refer to Table 11-8 for more information about using the available icons.

Several methods are available for extracting ions to generate an XIC, depending on whether chromatographic or
spectral data is used. Table 11-5 contains a summary of methods that can be used with chromatograms and
spectra.
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Table 11-5 Summary of XIC Generation Methods

ExtractionUse with SpectrumUse with
Chromatogram

Method

Extracts ions from a
selected area in a
spectrum.

YesNoSelected range

Extracts ions from a
selected area in a spectrum
using the most intense
peak in the selected area.
This option creates an XIC
using the maximum mass
from the selected spectral
range.

YesNoMaximum

Can be used only with Base
Peak Chromatograms
(BPCs). Use the Use Base
Peak Masses command to
extract ions results in an
XIC with a different colored
trace for each mass. If the
selection includes multiple
peaks, then the resulting
XIC will have an equal
number of colored traces,
one for each mass.

YesYesBase peak masses

Extracts ions from any type
of spectrum or
chromatogram. Select up
to ten start and stop
masses for which to
generate XICs.

YesYesSpecified masses

Generate an XIC Using a Selected Range

1. Open a data file containing spectra.

2. Select a range by pressing the left mouse button at the start of the range, dragging the cursor to the stop point,
and then releasing the left mouse button.

The selection is indicated in blue.
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3. Click Explore > Extract Ions > Use Range.

An XIC of the selection opens in a pane below the spectrum pane. The experiment information at the top of
the pane contains the mass range and the maximum intensity in counts per second.

Generate an XIC Using the Maximum Peak

1. Open a data file containing spectra.

2. Select a range in a spectrum.

The selection is indicated in blue.

3. Click Explore > Extract Ions > Use Maximum.

An XIC of the maximum peak specified selection opens below the spectrum pane. The experiment information
at the top of the pane contains the mass range and the maximum intensity in counts per second.

Generate an XIC Using Base Peak Masses

1. Open a data file containing spectra.

2. In a BPC, select the peak from which to extract ions.

The selection is indicated in blue.

3. Click Explore > Extract Ions > Use Base Peak Masses.

An XIC of the specified selection opens below the spectrum pane. The experiment information at the top of
the pane shows the mass range and the maximum intensity in counts per second.

Extract Ion by Selecting Masses

1. Open a spectrum or chromatogram.

2. Click Explore > Extract Ions > Use Dialog.

SCIEX Triple QuadTM 5500+ SystemSystem User Guide
133 / 194RUO-IDV-05-8450-A

Analyze and Explore Data



Figure 11-5 Extract Ions Dialog

3. Type the values for each XIC to be created. If a stop value is not typed, then the range is defined by the start
value.

• In the Start field, type the start value (lower value) for the mass range.

• In the Stop field, type the stop value (higher value) for the mass range.

4. Click OK.

An XIC of the selection opens below the chromatogram pane. The experiment information at the top of the
pane includes the masses and the maximum intensity in counts per second.

Generate BPCs
BPCs can be generated only from single-period, single-experiment data.

1. Open a data file.

2. Select an area within a TIC.

The selection is indicated in blue.
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3. Click Explore > Show > Show Base Peak Chromatogram.

The selections are shown in the Start Time and End Time fields.

Figure 11-6 Base Peak Chromatogram Options

4. In the Mass Tolerance field, type the value to indicate the mass range used to find a peak. The software
finds the peak using a value twice the typed range (± the mass value).

5. Type the intensity below which peaks are ignored by the algorithm in the Minimum Intensity field.

6. Type the mass that determines the beginning of the scan range in the Minimum Mass field.

7. Type the mass that determines the end of the scan range in the Maximum Mass field.

8. To set the start and end times, select the Use Limited Range check box and do the following:

• In the Start Time field, type the time that determines the start of the experiment.

• In the End Time field, type the time that determines the end of the experiment.

9. Click OK.

The BPC is generated in a new pane.
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Generate XWCs
An XWC is a wavelength chromatogram created by taking intensity values at a single wavelength, or by the sum
of the absorbance for a range of several wavelengths. Up to three ranges can be extracted from a DAD spectrum
to generate the XWC. Refer to Table 11-8 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.

2. Right-click anywhere in the pane and then click Extract Wavelengths.

Figure 11-7 Extract Wavelengths Dialog

3. Type Start and Stop values.

4. Click OK.

The XWC is shown in a pane below the DAD spectrum.

Generate DAD Data
Like mass spectrometer data, DAD data can be viewed in chromatogram or spectrum form. Users can view the
DAD spectrum for a single point in time, or for a range of time as a Total Wavelength Chromatogram (TWC).

1. Open a data file containing data acquired with a DAD.

The TWC, which is analogous to a TIC, opens in a pane below the TIC.

2. In the TWC pane, click a point to select a single point in time, or highlight an area of the spectrum to select a
range of time.

3. Click Explore > Show > Show DAD Spectrum.

The DAD spectrum opens in a pane below the TWC. The Y-axis shows the absorbance and the X-axis shows
the wavelength.
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Tip! If the pane with the TWC is closed, then click a point anywhere in the TWC to open it again. Click
Explore > Show > Show DAD TWC.

Generate TWCs
A TWC is a less commonly used chromatogram. It shows the total absorbance (mAU) as a function of time. The
TWC provides a way of viewing an entire data set in a single pane. It consists of the summed absorbances of all
ions in a scan plotted against time in a chromatographic pane. If the data contains results from multiple experiments,
then create individual TWCs for each experiment and another TWC that represents the sum of all experiments.

A TWC shows total absorbance (mAU) on the Y-axis plotted against time on the X-axis. Refer to Table 11-8 for
more information about using the available icons.

1. Open a data file that contains a DAD spectrum.

2. Click Explore > Show > Show DAD TWC.

The TWC is shown in a pane below the DAD spectrum.

Tip! Right-click inside the pane containing the DAD spectrum and then click Show DAD TWC.

Adjust the Threshold
The threshold is an invisible line drawn parallel to the X-axis of a graph that sets a limit below which the software
will not include peaks in a spectrum. The line has a handle, represented by a blue triangle to the left of the Y-axis.
Click the blue triangle to view a dotted line that represents the threshold. The threshold can be raised or lowered,
but changing the threshold value does not change the data. The software does not label any peaks in the region
that lies below the threshold.

1. Open a data file.

2. Do one of the following:

• To raise the threshold, drag the blue triangle up the Y-axis. To lower the threshold, drag the blue triangle
down.

• Click Explore > Set Threshold. In the Threshold Options dialog that opens, type the threshold value
and then click OK.

• Click Explore > Threshold.

The graph updates to show the new threshold. Peak labeling and the peak list are also updated.

Tip! To view the current threshold value, move the pointer over the threshold handle.
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Chromatogram Panes
Table 11-6 Right-click Menu for Chromatogram Panes

FunctionMenu

Lists the data points and integrates the peaks found in chromatograms.List Data

Generates a new pane containing the spectrum.Show Spectrum

Shows a color-coded plot of a data set, where the color represents the intensity of
the data at that point. Only certain MS modes are supported.

Show Contour Plot

Extracts a specific ion or set of ions from a selected pane and then generates a new
pane containing a chromatogram for the specific ions.

Extract Ions

Generates a new pane containing a base peak chromatogram.Show Base Peak
Chromatogram

Generates a new pane containing the ADC data trace, if acquired.Show ADC Data

Generates a new pane containing the UV data trace, if acquired.Show UV Detector Data

Opens the Spectral Arithmetic Wizard.Spectral Arithmetic Wizard

Generates a text file containing the data in a pane, which can be opened in Microsoft
Excel or other programs.

Save to Text File

Saves information about changes to processing parameters, also called processing
options, that were made when a wiff file was processed in Explore mode. The
processing history is stored in a file with an eph (Explore Processing History) extension.

Save Explore History

Adds a caption at the cursor point in the pane.Add Caption

Adds a text box at cursor point in the pane.Add User Text

Sets the subtract range in the pane.Set Subtract Range

Clears the subtract range in the pane.Clear Subtract Range

Locks or unlocks the subtract ranges. If the subtract ranges are not locked, then each
subtract range can be moved independently. The subtract ranges are preset to locked.

Subtract Range Locked

Deletes the selected pane.Delete Pane
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Spectra Panes
Table 11-7 Right-click Menu for Spectra Panes

FunctionMenu

Lists the data points and integrates chromatograms.List Data

Generates a new pane containing the TIC.Show TIC

Extracts a specific ion or set of ions from a selected pane and then
generates a new pane containing a chromatogram for the specific
ions.

Extract Ions (Use Range)

Extracts ions using the most intense peak in a selected area.Extract Ions (Use Maximum)

Generates a text file of the pane, which can be opened in Microsoft
Excel or other programs.

Save to Text File

Saves information about changes to processing parameters, also
called Processing Options, that were made when a wiff file was
processed in Explore mode. The processing history is stored in a file
with an eph (Explore Processing History) extension.

Save Explore History

Adds a caption at the cursor position in the pane.Add Caption

Adds a text box at the cursor position in the pane.Add User Text

Shows the scan prior to the selection.Show Last Scan

In this dialog, select the parameters to reduce peak labeling.Select Peaks For Label

Deletes the selected pane.Delete Pane

Adds records and compound-related data, including spectra, to the
library. An active spectrum is required to perform this task.

Add a Record

Searches the library without constraints or with previously saved
constraints.

Search Library

Searches the library using the criteria typed in Search Constraints
dialog.

Set Search Constraints

Graphical Data Processing
Graphical data can be processed many ways. This section provides information and procedures for using some of
the most commonly used tools.
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The user can zoom in on part of a graph to view a particular peak or an area in greater detail in both spectra and
chromatograms. The user can also zoom in repeatedly to view smaller peaks.

Graphs
The same data can be examined in different ways. Data can also be kept for comparison purposes before performing
processing operations such as smoothing or subtraction.

A window contains one or more panes arranged in such a way that all the panes are fully visible and that they do
not overlap.

Panes might be of a variable or fixed size. Panes are automatically tiled within the window and are arranged into
column and row format. If the size of a window is changed, then the panes within the window change in size to
accommodate the new size. A window cannot be sized to the point where any of the panes become smaller than
their minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass
ranges. As one pane or window is zoomed in, the other pane zooms in simultaneously. For example, the user can
link an XIC to the BPC from which the XIC was extracted. Zooming in the BPC also zooms the XIC, so that both
chromatograms show the same magnification.

Manage Data
Data can be compared or examined in different ways. Users might want to keep the data for comparison purposes
before performing processing operations such as smoothing or subtraction.

A window contains one or more panes, arranged in such a way that all the panes are fully visible and they do not
overlap.

Panes can be of variable or fixed size. Panes are automatically tiled within the window and are arranged into
column and row format. If window size is changed, then the panes within the window change in size to
accommodate the resizing. A window cannot be resized to the point where any of the panes would become smaller
than its minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass
ranges. When the user zooms in one pane or window, the other pane zooms simultaneously. For example, the
user can link an XIC to the BPC from which it was extracted. Zooming in the BPC also zooms the XIC, so that both
chromatograms are shown with the same magnification.

• Use the following menu options or icons to manage data in graphs.
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Table 11-8 Graph Options

...or click this iconuse this menu option...To do this...

Select the graph to copy. Click Explore > Duplicate
Data > In New Window.

Copy a graph to a new
window

Select the graph. Click Explore > Home Graph.Rescale a graph to its
original size

• Select the graph. Click Window > Move Pane.

• Select the pane or window and then drag it to the new
position. This position can be inside the same window
or within another window.

A four-headed arrow is shown when the cursor is on the
boundary of the active window or pane.

• If the pane is at the top or bottom of the target pane,
then the pane moves above or below that pane,
respectively.

• If the pane is at the left or right of the target pane, then
the pane moves to the left or right of that pane,
respectively.

• If the pane is at any other position, then the pane
moves to the target row. The drop shadow of the pane
as the pane is moved indicates its new position.

Move a pane

a. With the two graphs open, click one to make that pane
active.

b. Click Explore > Link and then click the other pane.

Link panes

Close one of the panes. Click Explore > Remove Link.Remove linking

Select the graph. Click Window > Delete Pane.Delete a pane

Select the graph. Click Window > Lock Panes.Lock a pane

Select the graph. Click Window > Hide Pane.Hide a pane
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Table 11-8 Graph Options (continued)

...or click this iconuse this menu option...To do this...

Select the graph. Click Window > Maximize Pane.Maximize a pane

Select the graph. Click Window > Tile all Panes.Tile panes

Zoom In on the Y-axis

1. Move the pointer to the left of the Y-axis to either side of the area to be expanded and then drag away from
the starting point in a vertical direction while holding the left mouse button.

A box is drawn along the y-axis representing the new scale.

Note: Take care when zooming in on the baseline. Zoom in too far and the zoom-in box closes.

2. Release the mouse button to draw the graph to the new scale.

Zoom In on the X-axis

Tip! To return the graph to the original scale, double-click either axis. To restore the entire graph to the original
scale, click Explore > Home Graph.

1. Move the pointer under the X-axis to either side of the area to be expanded and then drag away from the
starting point in a horizontal direction while holding the left mouse button.

2. Release the mouse button to draw the graph to the new scale.
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The Reporter software extends the reporting functionality available in the Analyst
®
 software.

We recommend that users validate the results if a modified Reporter template or one that contains a query is used.

The Reporter software can be used to create custom reports with Microsoft Word and Excel (2010, 2013, or 2016).
The Reporter software has the following features:

• Provides a variety of reports that use the data available in a Results Table, in file information, and in quantitative
peak review windows.

• Provides a variety of reports that present MS/MS library search results. The user can configure the Reporter
software to search against any MS/MS spectral library that uses the Analyst

®
 (mdb) format.

• Uses Microsoft Word templates to provide the format information needed when generating reports. These
templates can be created or modified to provide customized report formats. Refer to the Help for information
about creating or editing the Report Template Editor.

• Contains a blank starting template that can be used in the Analyst
®
 software Reporter editing environment to

design report templates to meet most reporting requirements.

• Automates report generation through the use of the Autoquan Reporter batch script.

• Automatically prints, exports to Adobe Portable Document Format (pdf), and delivers results by e-mail.

• Attaches processing scripts to report templates to expand both the content and automation level for various
workflow requirements.

• Generates reports from custom software applications that use the available Analyst
®
 software programming

libraries.

Reporter software can be used as follows:

• Within the Analyst
®
 software to manually generate a report or set of reports.

• By a batch script to automate report generation within a batch. Users can generate reports on a
sample-by-sample basis, either during or after batch acquisition.

• By applications that do not use the Analyst
®
 software.
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Analyst Reporter User Interface

Figure 12-1 Analyst Reporter

DescriptionOptionItem

Exits the program and releases all resources.File > Exit1

Sets the language dictionary that will be used to replace language tags
within a report template. Templates that contain language tags can
be used to generate reports in any language. The language tags are
replaced with text from a matching tag in the dictionary file for the
selected language. These dictionary files are contained in the folder:
C:\Program Files\AB SCIEX\AnalystReporter\Resources\Languages on
Windows 7, 32- bit operating systems or C:\Program Files (x86)\AB
SCIEX\AnalystReporter\Resources\Languages on Windows 7, 64-bit or
Windows 10, 64-bit operating systems.

Settings > Select
Output Language

2

Browse to a spectral library. This library will be used for matching and
scoring MS/MS data from Results Tables that contain data from
information dependent acquisition (IDA) triggered MS/MS scan types.

Settings > Select
Library

2
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DescriptionOptionItem

Sets the folder from which the available templates will be read. To
return to the default template folder, select the Default option.

Settings > Select
Template Folder

2

Shows information about the version of Reporter software currently
installed.

Help > About3

Shows the currently selected language dictionary used for replacing
language tags within a report template. The language dictionary can
be selected using Settings > Select Output Language.

Current Output
Language

4

Shows the currently selected spectral library. The spectral library can
be selected using Settings > Select Library.

Current Spectral
Library

5

Shows a list of available report templates. Selecting a template will
show a description of the template. To change the folder from which
available templates are read, select Settings > Select Template
Folder > Browse.

Available Templates
and Description

6

Shows the output formats that are supported by the Reporter software.
Only formats that are compatible with the selected report template are
enabled.

• Word: Microsoft Word document (docx) is produced. This document
can be viewed by Microsoft Word 2010 and above.

• PDF: A report is created directly in PDF format.

• HTML: Microsoft Word is used to generate an HTML file. Associated
image files are stored in a folder with the same name as the HTML
file.

• Excel: A plain text file (csv) is produced. Report templates that
contain values separated by commas can be opened in Microsoft
Excel, where each value will be shown in a separate cell. Only
templates that are specifically marked as text-compatible can be
used for this output format.

• Text: A plain text document (txt) is produced. Only templates that
are specifically marked as text compatible can be used for this
output format.

Output Format7

After the report has been created it is printed to the selected printer.
Select any available printer.

Print Automatically8

Creates the report in the selected output format using the selected
report template.

Create Report9

Exits the program and releases all resources.Close10
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Generate Reports
The Reporter software extracts numerical data from the Results Table and sample and graphical information from
the wiff file.

Select a template in the Available Template field.

Tip! For reports that can be generated on a sample-by-sample basis, it may be more efficient to generate the
reports automatically using a batch script during acquisition to avoid long processing times at the end of the
acquisition. For more information about batch scripts, refer to the Scripts User Guide.

1. Open a Results Table.

2. Under Companion Software, double-click Reporter.

3. In the Analyst Reporter dialog, in the Available Templates field, select the applicable report template.

4. Click the PDF output format.

The Word option is pre-selected and the report is automatically saved in the current project Results folder. If
this option is not selected, then the report is created and opened in Word or printed as selected, but the report
is not saved. This lets the user edit the report in Word prior to saving the original report.

5. Select either one document containing all samples or multiple documents with one sample in each.

6. (Optional) Select the Print Automatically check box to print the reports automatically on a pre-selected
printer.

The Default Printer set in Windows is used unless a different printer is selected. The Reporter tool retains the
selected printer between operations. If the printer is set to a PDF printer driver, then the Reporter generates
PDF file versions of the created reports automatically.

7. Click Create Report.

The screen shows various progress indicators as the tool opens the template and populates it with data from
the Results Table. Some reports can take seconds to generate, others can take longer. A large data set with
many MRM transitions or a large number of graphics might result in reports of several hundred pages that
take hours to generate.
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Regularly clean and maintain the system for optimal performance.

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the
covers might cause injury or malfunctioning of the system. The covers need
not be removed for routine maintenance, inspection, or adjustment. Contact
a SCIEX Field Service Employee (FSE) for repairs that require the covers to be
removed.

WARNING!  Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Determine whether decontamination is required prior to cleaning or
maintenance. The customer must decontaminate the system prior to cleaning
or maintenance if radioactive materials, biological agents, or toxic chemicals
have been used with the system.

Recommended Maintenance Schedule
The following tables provide a recommended schedule for cleaning and maintaining the system.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

For information on maintaining the ion source, refer to the ion source Operator Guide.

Contact a Qualified Maintenance Person (QMP) to order consumable parts. Contact a SCIEX Field Service Employee
(FSE) for maintenance service and support.

Table 13-1 Mass Spectrometer Maintenance Tasks

For more information...TaskFrequencyComponent

Refer to Chemical Precautions.Inspect for leaksDailySystem

Refer to Clean the Curtain Plate.CleanDailyCurtain plate

Clean the Front of the Orifice Plate.CleanDailyOrifice plate (front)

Refer to Inspect the Roughing Pump Oil
Level. Contact the local QMP or FSE to
add oil, if required.

Inspect the levelWeeklyRoughing pump oil
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Table 13-1 Mass Spectrometer Maintenance Tasks (continued)

For more information...TaskFrequencyComponent

Contact the local QMP or FSE.ReplaceEvery 6 monthsMass spectrometer
air filter

Contact the local QMP or FSE.ReplaceAnnuallyRoughing pump oil

Contact the local QMP or FSE.CleanAs neededOrifice plate (front
and back)

Contact the local QMP or FSE.CleanAs neededIonDriveTM QJet ion
guide and IQ0 lens

Contact the local QMP or FSE.CleanAs neededQ0 rod set and IQ1
lens

Refer to Clean the Surfaces.CleanAs neededInstrument
surfaces

Refer to Empty the Source Exhaust
Drain Bottle.

EmptyAs neededSource exhaust
drain bottle

Contact the local QMP or FSE.ReplaceAs neededInterface heater

Contact the local QMP or FSE.RefillAs neededRoughing pump oil

Table 13-2 Ion Source Maintenance Tasks

For more information...TaskFrequencyComponent

Refer to the Operator Guide for the
ion source.

Inspect and replaceAs neededTurboIonSpray
®

and APCI probes

Refer to the Operator Guide for the
ion source.

Inspect and replaceAs neededTurboIonSpray
®

and APCI
electrodes

Refer to the Operator Guide for the
ion source.

ReplaceAs neededCorona discharge
needle

Contact the local QMP or FSE.ReplaceAs neededTurbo heater
(Turbo VTM and
DuoSprayTM ion
sources)

Refer to the Operator Guide for the
ion source.

ReplaceAs neededSample tubing
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For “As needed” tasks, follow these guidelines:

• Clean the mass spectrometer surfaces after a spill or when they become dirty.

• Empty the drain bottle before it becomes full.

• Clean the orifice plate, IonDriveTM QJet ion guide, and Q0 region if system sensitivity degrades.

Tip! Clean the Q0 region regularly to minimize the impact of charging (a significant loss of sensitivity of the
ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

• Clean the IonDriveTM QJet ion guide and Q0 region if system sensitivity degrades.

Tip! Clean the Q0 region regularly to minimize the impact of charging (a significant loss of sensitivity of the
ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

• Refill the roughing pump oil when it falls below the minimum oil level.

Clean the Surfaces
Clean the external surfaces of the mass spectrometer after a spill or when they become dirty.

CAUTION: Potential System Damage. Use only the recommended cleaning methods and
materials to avoid damaging the equipment.

1. Wipe the external surfaces with a soft cloth dampened with warm, soapy water.

2. Wipe the external surfaces with a soft cloth moistened with water to remove any soap residue.

Clean the Front-End
The following warning applies to all of the procedures in this section:

Clean the mass spectrometer front-end using the routine cleaning method, to:

• Minimize unscheduled system downtime.

• Maintain optimum sensitivity.

• Avoid more extensive cleaning that requires a service visit.

When contamination occurs, perform an initial routine cleaning. Clean up to and including the front of the orifice
plate. If routine cleaning does not resolve issues with sensitivity, then a full cleaning might be necessary. Contact
the local QMP or FSE.

This section provides instructions for performing routine cleaning without breaking vacuum.
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Note: Follow all of the applicable local regulations. For health and safety guidelines, refer to Chemical
Precautions.

Symptoms of Contamination
The system might be contaminated if any one of the following is observed:

• Significant loss in sensitivity

• Increased background noise

• Additional peaks that are not part of the sample are shown in full scan or survey scan methods

If any of these issues are observed, then clean the mass spectrometer front-end.

Required Materials

Note: U.S. customers can call 877-740-2129 for ordering information and inquiries. International customers
can visit sciex.com/contact-us.

• Powder-free gloves (nitrile or neoprene recommended)

• Safety glasses

• Laboratory coat

• Fresh, high-quality (pure) water (at least 18 MΩ de-ionized [DI] water or ultra-pure HPLC-grade water). Old
water can contain contaminants that can further contaminate the mass spectrometer.

• MS-grade methanol, isopropanol (2-propanol), or acetonitrile

• Cleaning solution. Use one of:

• 100% methanol

• 100% isopropanol

• 1:1 acetonitrile:water solution (freshly prepared)

• 1:1 acetonitrile:water with 0.1% acetic acid solution (freshly prepared)

• Clean 1 L or 500 mL glass beaker to prepare cleaning solutions

• 1 L beaker to catch used solvent

• Organic waste container

• Lint-free wipes. Refer to Tools and Supplies Available from the Manufacturer.

• (Optional) Polyester (poly) swabs
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Tools and Supplies Available from the Manufacturer

Part NumberDescription

1017396Small poly swab (thermally bonded). Also available in the Cleaning kit.

018027Lint-free wipe (11 cm x 21 cm, 4.3 inches x 8.3 inches). Also available in the Cleaning
kit.

5021294Cleaning kit. Contains the small poly swab, lint-free wipes, Q0 cleaning tool, tapered
IonDriveTM QJet ion guide cleaning brush, Q0 cleaning brush, and Alconox packets.

Cleaning Best Practices

WARNING! Hot Surface Hazard. When using the Turbo VTM or DuoSprayTM

ion source, let the ion source and interface cool for at least 30 minutes before
starting any maintenance procedures. Some surfaces of the ion source and
vacuum interface become hot during operation.

WARNING!  Toxic Chemical Hazard. Refer to the chemical product Safety Data Sheets
and follow all of the recommended safety procedures when handling, storing, and
disposing of chemicals. For health and safety precautions, refer to the System User
Guide.

WARNING!  Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Determine whether decontamination is required prior to cleaning or
maintenance. The customer must decontaminate the system prior to cleaning
or maintenance if radioactive materials, biological agents, or toxic chemicals
have been used with the system.

WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

• Allow the ion source to cool before removing it.

• Always wear clean, powder-free gloves (nitrile or neoprene recommended) for the cleaning procedures.

• After cleaning the mass spectrometer components, and before reassembling them, put on a new, clean pair
of gloves.

• Do not use cleaning supplies other than those specified in this procedure.

SCIEX Triple QuadTM 5500+ SystemSystem User Guide
151 / 194RUO-IDV-05-8450-A

Service and Maintenance Information



• If possible, prepare cleaning solutions just before cleaning.

• Prepare and store all of the organic solutions and organic-containing solutions in very clean glassware only.
Never use plastic bottles. Contaminants can leach from these bottles and further contaminate the mass
spectrometer.

• To avoid contaminating the cleaning solution, pour the solution on the wipe or swab.

• Allow only the center area of the wipe to contact the mass spectrometer surface. Cut edges can leave fibers
behind.

Tip! Wrap the wipe around a thermally-bonded poly swab.

Figure 13-1 Example: Folding the Wipe

• To avoid cross-contamination, discard the wipe or swab after it has touched the surface once.

• Larger parts of the vacuum interface, such as the curtain plate, might require several cleanings, using multiple
wipes.

• Only dampen the wipe or swab slightly when applying water or cleaning solution. Water, more often than
organic solvents, might cause the wipe to deteriorate, leaving residue on the mass spectrometer.

• Do not rub the wipe across the aperture. Wipe around the aperture to prevent fibers from the wipes from
entering the mass spectrometer.

• Do not insert the brush in the aperture on the curtain plate or orifice plate.

Prepare the Mass Spectrometer

WARNING! Hot Surface Hazard. Let the ion source cool for at least 30 minutes
before starting any maintenance procedures. Surfaces of the ion source and
the vacuum interface components become hot during operation.
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CAUTION: Potential System Damage. Do not drop anything into the source drain when the
ion source is removed.

Figure 13-2 Source Drain on the Vacuum Interface

1. Deactivate the hardware profile.

2. Remove the ion source. Refer to the ion source Operator Guide.

When the ion source is not in use, store it to protect it from damage and to maintain operating integrity.

Clean the Curtain Plate

CAUTION: Potential System Damage. Do not rest the curtain plate or orifice plate on the
aperture tip. Make sure that the conical side of the curtain plate faces up.

CAUTION: Potential System Damage. Do not insert a wire or metal brush into the aperture
on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Pull the curtain plate off of the vacuum interface and then put it, conical side up, on a clean, stable surface.

The curtain plate is held in place by three retaining ball catches mounted on the orifice plate.

Tip! If the curtain plate does not immediately separate from the orifice plate, then turn the curtain plate
slightly (less than 90 degrees) to release the ball spring latches.
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2. Dampen a lint-free wipe with pure water and then clean both sides of the curtain plate.

Note: Use multiple wipes, as required.

3. Repeat step  2 using the cleaning solution.

4. Using a dampened wipe or small poly swab, clean the aperture.

5. Wait until the curtain plate is dry.

6. Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free
wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Clean the Front of the Orifice Plate

CAUTION: Potential System Damage. When cleaning the surface of the orifice plate, do
not remove the interface heater. Frequent removal of the interface heater can result in
damage to the interface heater. Surface cleaning of the interface heater is adequate for
routine cleaning.

CAUTION: Potential System Damage. Do not insert a wire or metal brush into the aperture
on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Dampen a lint-free wipe with water and then wipe the front of the orifice plate, including the interface heater.

2. Repeat step  1 using the cleaning solution.

3. Wait until the orifice plate is dry.

4. Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free
wipe.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Put the Mass Spectrometer Back in Service

1. Install the curtain plate on the mass spectrometer.

2. Install the ion source on the mass spectrometer. Refer to the ion source Operator Guide.

3. Activate the hardware profile. Refer to the System User Guide.
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Inspect the Roughing Pump Oil Level

• Inspect the sight glass on the roughing pump to verify that the oil is above the minimum level.

If the oil is below the minimum level, then contact the qualified maintenance person (QMP) or SCIEX field
service employee (FSE).

Empty the Source Exhaust Drain Bottle

WARNING!  Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Deposit hazardous materials in appropriately labeled waste containers and
dispose of them according to local regulations.

WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Take care to vent exhaust gases to a dedicated laboratory fume hood or
exhaust system and make sure that the ventilation tubing is secured with
clamps. Make sure that the laboratory has appropriate air exchange for the
work performed.

Inspect the source exhaust drain bottle regularly, and empty it before it becomes full. Also inspect the bottle and
its fitting for leaks, and tighten connections or replace components, if required. Follow the steps in this procedure
to empty the bottle.

1. Remove the ion source. Refer to the ion source Operator Guide.

2. Loosen the clamps connecting the hoses to the cap of the source exhaust drain bottle.
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Figure 13-3 Source Exhaust Drain Bottle

DescriptionItem

Connection to vent1

Source exhaust drain tubing: 2.5 cm (1.0 inch) inside diameter (i.d.)2

Roughing pump exhaust hose: 3.2 cm (1.25 inch) i.d.3

Source exhaust drain bottle. Make sure that the bottle is secured to prevent spillage.4

Connection to the mass spectrometer: 1.6 cm (0.625 inch) i.d.5

Note: Source exhaust hose connections at the drain bottle, mass spectrometer, and the lab vent are secured
with hose clamps.

3. Disconnect the hoses from the cap.

4. If applicable, lift the drain bottle out of the holder.

5. Remove the cap from the drain bottle.

6. Empty the drain bottle and then dispose of the waste according to laboratory procedures and local waste
regulations.
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7. Install the cap on the bottle and then put the bottle in the holder.

8. Attach the hoses to the cap and then secure them tightly with clamps.

Storage and Handling

WARNING! Environmental Hazard. Do not dispose of system components in municipal
waste. Follow local regulations when disposing of components.

If the mass spectrometer must be stored for a long time or prepared for shipping, then contact a SCIEX FSE for
decommissioning information. To disconnect power from the mass spectrometer, remove the mains supply connector
from the AC mains supply.

Note: The ion source and mass spectrometer must be transported and stored between –30 °C to +60 °C (–22
°F to 140 °F). Store the system at an altitude not exceeding 2 000 m (6 562 feet) above sea level.
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This section contains information for troubleshooting basic system issues. Certain activities can only be carried
out by a SCIEX -trained Qualified Maintenance Person (QMP) in the laboratory. For advanced troubleshooting,
contact a SCIEX Field Service Employee (FSE).

Table 14-1 System Issues

Corrective ActionPossible CauseSymptom

Verify the setting for the CUR
parameter, and increase it, if
applicable.

The Curtain GasTM flow rate is too
low.

The IonDriveTM QJet ion guide is
extremely dirty or frequently
becomes dirty.

1. Inspect the roughing pump oil
level, and then contact the local
QMP or an FSE to add oil.

2. Inspect and repair leaks.

3. Install the correct orifice plate.

1. The roughing pump oil level is
too low.

2. There is a leak.

3. The wrong orifice plate is
installed.

A system fault has occurred because
the vacuum pressure is too high.

Contact the local QMP or FSE.1. The mass spectrometer air filter
is blocked.

2. Ambient temperature is too high.

A system fault has occurred because
the QPS exciter module temperature
is too high.

1. Confirm the fault in the Status
panel of the device details page.

2. Install the probe. Refer to the
Operator Guide for the ion
source.

3. Remove and replace the probe.
Tighten the retaining ring
securely. Refer to the Operator
Guide for the ion source.

1. The probe is not installed.

2. The probe is not connected
securely.

The Analyst
®
 software reports that

the mass spectrometer is in Fault
status because of the ion source.

Contact an FSE.The F3 fuse is blown.The Analyst
®
 software indicates that

the APCI probe is in use, but the
TurboIonSpray

®
 probe is installed.
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Table 14-1 System Issues (continued)

Corrective ActionPossible CauseSymptom

Clean or replace the electrode. Refer
to the Operator Guide for the ion
source.

The electrode is blocked.The spray is not uniform.

1. Optimize the ion source
parameters.

2. Use the Instrument Optimization
wizard to optimize the mass
spectrometer.

3. Clean the curtain plate. Refer to
Clean the Curtain Plate.

4. Clean the orifice plate. Refer to
Clean the Front of the Orifice
Plate or contact the local QMP or
FSE.

5. Clean the IonDriveTM QJet ion
guide and IQ0 lens. Contact the
local QMP or FSE.

6. Test for contamination of the Q0
region. Contact the local QMP or
FSE.

1. The ion source parameters are
not optimized.

2. The mass spectrometer is not
optimized.

3. The curtain plate is dirty.

4. The orifice plate is dirty.

5. The IonDriveTM QJet ion guide or
IQ0 lens is dirty.

6. The Q0 region is dirty.

Sensitivity is reduced.
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Table 14-1 System Issues (continued)

Corrective ActionPossible CauseSymptom

1. Inspect the syringe or sample line
for leaks, and repair any leaks
found. Make sure that all fittings
are the correct type and size.

2. Verify the sample concentration.
Use a fresh sample.

3. Remove and install the probe.

4. Remove and install the ion
source, making sure that the
latches are properly secured. If
this does not resolve the issue,
then install and optimize an
alternate ion source.

5. If the O-rings are on the ion
source, then install them on the
vacuum interface. If they are
missing, then replace them.

6. Troubleshoot the LC system.

1. The syringe or sample line is
leaking.

2. The sample has degraded or has
a low concentration.

3. The probe is not installed
properly.

4. The ion source is not installed
properly, or it is faulty.

5. One or more of the O-rings on the
vacuum interface is missing.

6. There is an issue with the LC
system or connections.

Sensitivity is reduced.
(continued)
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Table 14-1 System Issues (continued)

Corrective ActionPossible CauseSymptom

1. Optimize the probe. Refer to the
Operator Guide for the ion
source.

2. Confirm that the sample was
prepared correctly.

3. Verify that the fittings are the
right size and type and make sure
that they are tight. Do not
overtighten the fittings. Replace
the fittings if leaks continue.

4. Install and optimize an alternate
ion source.

5. Contact an FSE if the issue
persists.

1. The probe is not optimized.

2. The sample was not prepared
correctly or the sample has
degraded.

3. The sample inlet fittings are
leaking.

The mass spectrometer performance
has degraded.

If the TurboIonSpray
®
 probe is being

used, then turn the corona discharge
needle toward the curtain plate, and
away from the stream of heater gas.
Refer to the Operator Guide for
the ion source.

The position of the corona discharge
needle is incorrect.

Arcing or sparks occur.

For sales, technical assistance, or service, contact an FSE or visit the SCIEX website at sciex.com for contact
information.
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The user must control the autosampler and injection valve manually, as these devices cannot be controlled through
the system while it is in Tune and Calibrate mode.

Prerequisites

• The mass spectrometer is tuned and calibrated.

• Conditions for an LC separation are known.

• All of the required peripheral devices, including the syringe pump, if needed, and LC components are in the
hardware profile.

Required Materials

To tune instrument parameters for particular compounds the following solutions are recommended. The mixture
of four compounds is used for illustrating the steps of the procedure.

• Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.

• LC pump and autosampler.

• Autosampler vials.

Table A-1 Compounds and Molecular Weights

m/zCompound

210.2Minoxidil

271.1Tolbutamide

609.3Reserpine

635.3Rescinnamine

About Manual Compound Optimization
Manual compound optimization is used to optimize compound- and ion source-dependent parameters for an
analyte. When the user manually optimizes for an analyte, an MS acquisition method is created in Tune and
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Calibrate mode. Depending on the method of sample introduction selected, add an LC method to the acquisition
method so that infusion or LC can be used.

Optimizing to give the highest signal does not always give the highest signal-to-noise ratios. Noise can scale with
signal for some parameters and should be verified during optimization if the goal is to obtain maximum
signal-to-noise ratio.

When optimizing ion source-dependent parameters, introduce the sample at flow rates that will be used during
sample analysis, using either flow injection analysis (FIA) or Tee-infusion as the method of sample introduction.
The CAD gas is the only compound-dependent parameter that is shown on the Source/Gas tab and can be easily
optimized while infusing the analyte.

Optimize the position of the ion source before optimizing the ion source-dependent parameters. Refer to the ion
source Operator Guide.

About Scan Types
For this example, use the Q1 MS, Q1 MI, Product Ion, and MRM scan types. The Q1 MS scan type is used to confirm
the presence of compounds of interest. The Q1 MI scan is used to optimize MS or pre-collision cell voltages. The
Product Ion scan type is used to determine the product ions of each compound. The MRM scan type is used to
optimize the collision energy (CE) and collision cell exit potential (CXP) for each product ion or fragment. Use the
methods created in this section for quantitative or qualitative analysis.

Manually Optimize an Analyte
After the acquisition method is created, optimize compound-dependent parameters using the Edit Ramp function
or by manually editing the parameters in the Tune Method Editor. Ion source-dependent parameters can be
optimized only by manually adjusting the parameters in the Tune Method Editor. Depending on the scan type
used, different parameters are available to optimize.

Follow the procedures in the order given:

1. Confirm the Presence of Compounds

2. Optimize MS-Specific Parameters

3. Determine the Product Ions for Optimization

4. Optimize Collision Cell Exit Potential for each Product Ion

Confirm the Presence of Compounds

1. Create a project.

2. Activate the hardware profile.
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3. Prepare the sample:

a. Aspirate the compound solution into a syringe and remove the air from the syringe.

b. Use the tubing with the special fitting to connect the syringe to the mass spectrometer.

c. Install the syringe in the integrated syringe pump.

4. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.

5. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

6. On the Syringe Pump Method Properties tab, type the parameter values shown in Table A-2.

Table A-2 Syringe Pump Method Properties Tab

ValueParameter

Syringe dependent. 4.610 mm if a 1.0 mL syringe is usedSyringe Diameter

10Flow Rate

µL/minUnit

Figure A-1 Syringe Pump Method Properties Tab

7. Click Start Syringe Pump.

8. Click MS Method from the method list.

9. Click Start.

10. Wait until an even TIC is shown on the left and peaks are shown on the right and then click Stop.

11. Select the MCA check box.

12. Type 10 In the Cycles field.

13. Click Start.

14. When ten scans are complete, the masses of the four compounds are shown as ions.
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Tip! If the previous or expected ion chromatogram pane is hidden, then select the window to be shown
from the Window menu.

Note: Ion intensities of the compounds can show large variances. To facilitate moving to a solution of higher
or lower concentration as needed during the optimization, have several concentration levels prepared before
beginning optimization.

15. Right-click the bottom-right spectral pane and then click Open File.

16. Find the compounds of interest and then write down the m/z values for the highest peaks. These values should
be within 0.1 Da to 0.2 Da of the expected m/z. In the next procedure, use the m/z values.

Optimize MS-Specific Parameters
The DP is the difference between the orifice and the ground. The higher the potential difference, the greater the
amount of declustering.

The DP parameter has a significant effect on analyte signal. Typical DP values range from 20 V to 150 V. A DP
value that is too low will result in lower ion intensity and potential interferences from clusters. A DP value that is
too high can cause fragmentation of the analyte in the source. Generally, the DP should be set to the value that
provides the highest intensity.

The EP parameter controls the entrance potential, which guides and focuses the ions through the high-pressure
Q0 region. It is typically set at 10 V for positive ions or –10 V for negative ions. The EP has a minor effect on
compound optimization and can generally be left at default values without impact on analyte detection limits.

1. Return to the Tune Method Editor and change the method to the Q1 Multiple Ions (Q1 MI) scan type.

2. In the mass table, type the appropriate parameter values. Refer to Table A-3.

Table A-3 Mass Table Parameters—Q1 Multiple Ions (Q1 MI)

TimeQ1 MassCompound

1609.4Reserpine

1210.2Minoxidil

1271.3Tolbutamide

1635.4Rescinnamine

Start with reserpine for a simple case. Repeat the manual optimization process for the remaining compounds.

3. Click Edit Ramp.

4. Select Declustering Potential (DP) in the Ramp Parameter Settings dialog.
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Note: Start with the DP parameter and then optimize the other parameters in the order that they are shown
in the dialog. The parameters might not be optimized correctly if they are optimized out of order.

5. Type the required Start, Stop, and Step values.

Tip! The existing values are good starting points. Use the Edit Ramp function to change these values to
be more efficient.

6. Click OK.

7. Click Start.

8. Right-click the bottom-right XIC pane and then click Open File to maximize the XIC view.

9. Monitor the XICs.

Note: The value that gives the best signal per second for the ion of interest is the optimal value.

10. Note the optimal value for the ion of interest.

11. Move the cursor to the mass table, right-click, and then add the parameter just optimized.

A column is added to the table.

12. Add the optimized value to the appropriate row.

13. Repeat these steps for each mass in the acquisition method until there is a list of optimal values for all of the
masses.

14. Repeat these steps to optimize for the other MS-specific parameters.

Table A-4 MS-Specific Parameters

CommentParameter

Set the DP to the value that provides the highest intensity.DP

Rarely optimize this parameter because it has a smaller effect.EP

Determine the Product Ions for Optimization
The collision energy (CE) controls the amount of energy that the precursor ions receive as they are accelerated
into the collision cell.

Perform this procedure, one compound at a time, using the MS-specific optimized values that were obtained
previously. The product ions provide the Q3 mass of MRM transitions.
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In this example, the compound reserpine is used.

1. In the Tune Method Editor, close the XIC panes.

2. Click Product Ion (MS2) in the Scan type field.

3. Click the Compound tab and then type the optimal value noted previously.

4. On the MS tab, in the Product Of field, type 609.4. This value is the mass assignment for reserpine that
was noted in Confirm the Presence of Compounds.

5. Make sure that the Center / Width check box is not selected.

6. In the mass table, type the appropriate Start, Stop, and TIme values. Refer to Table A-5.

Table A-5 Mass Table Parameters (Product Ion Scan)

ValueField

100Start (Da)

650Stop (Da)

2Time (sec)

7. Click Edit Ramp.

8. In the Ramp Parameter Settings dialog, select Collision Energy and then type the required Start, Stop,
and Step values.

Note: The existing values are good starting points. Use the Edit Ramp function to change these values
to be more efficient.

9. Click OK.

10. Select the MCA check box.

11. Click Start.

12. Right-click the bottom-right XIC pane and then click Open File.

13. Select the product ions with the greatest intensity and note the product ion m/z value to the first decimal
point, such as 195.1.

We recommend that two or three product ions be optimized for each compound. The additional transitions
can be used for confirmation, or to avoid the need to re-optimize a compound in case an interference is found.
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Note: Make sure that the highest peaks selected for optimization do not represent a common loss from the
precursor ion, such as water or carbon dioxide. Also make sure that the product ion is not too low in mass
or interferences might occur for that transition in real samples or clusters from the mobile phase when
analyzing on column.

14. Repeat this procedure for the remaining compounds.

Optimize Collision Cell Exit Potential for each Product Ion

1. In the Tune Method Editor, close the XIC panes.

2. Open the previously saved method.

3. In the mass table, verify the Q1 and Q3 m/z values for the compound.

4. Click the Compound tab and then type the optimal DP and CE values noted previously.

5. Click Edit Ramp.

6. Select Collision Cell Exit Potential (CXP) in the Ramp Parameter Settings dialog.

7. Type the required Start, Stop, and Step values.

Tip! The existing values are good starting points. Use the Edit Ramp function to change these values to
be more efficient.

8. Click OK.

9. Click Start.

10. Right-click the bottom-right XIC pane and then click Open File.

11. Note the optimal value for the ion of interest.

The value that gives the best signal is the optimal value.

12. In the mass table, right-click and then select the parameter just optimized.

This adds a column to the table.

13. Repeat if other product ions were monitored.

14. Add the optimized values to the appropriate row.

15. Save the method.

16. Repeat this procedure for any other compounds that were previously optimized.
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Manually Optimize the Ion Source and Gas
Parameters
The ion source and gas settings must be set correctly to prevent contamination of the mass spectrometer and to
make sure that the compounds of interest are optimally put into the gas phase as ions.

Note: The optimal ion source and gas settings are related to the solvent composition and the flow rate.

The ion source and gas settings must be adjusted when the LC conditions change significantly.

To optimize the ion source and gas parameters, set up a syringe pump with the compounds of interest and connect
the line with a tee to the LC device. Controlling the LC pump can be done manually or through the software.

Another way to manually optimize ion source and gas settings is to use the autosampler to manually inject the
compound of interest while manually varying the parameters in manual tuning to find the optimal settings.

Prepare the Ion Source

1. Set the horizontal micrometer to 5.

2. Set the vertical micrometer on the ion source for the flow rate.

Use the parameters in Table A-6.

Table A-6 Turbo VTMIon Source Vertical Parameters

Initial Vertical ParametersFlow Rate

101 µL/min to 20 µL/min

520 µL/min to 250 µL/min

2250 µL/min to 500 µL/min

0500 + µL/min

Depending on how the optimization is run, a hardware profile with the LC pumps might need to be configured.

Refer to the ion source Operator Guide.

Optimize the Ion Source Parameters
Ion source parameters are optimized for best signal-to-noise for the compound of interest. The Curtain GasTM

supply is optimized at the highest setting without losing sensitivity. Refer to the ion source Operator Guide.

Use the following procedure to optimize the Curtain GasTM flow parameter. The main function of the Curtain GasTM

flow parameter is to prevent the contamination of the ion optics. The Curtain GasTM flow parameter should always
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be maintained as high as possible without losing sensitivity. The value depends on the type of mass spectrometer
and ion source.

Do not set the parameter below the starting value.

The minimum flow rate supported by the APCI probe is 200 µL/min.

Note: Depending on the mass spectrometer, all parameters might not be available.

1. On the Navigation bar, under Tune and Calibrate, double-click Manual Tuning.

2. Click File > Open.

3. In the Files list, click the acquisition method used to optimize the compound parameter and then click OK.

The method opens in the Tune Method Editor.

4. Click the Source/Gas tab.

5. Using the ion source and gas flow guide, set all of the ion source and gas parameters so that they are appropriate
for the flow rate.

6. Set the run time long enough so that many parameters can be adjusted. A recommended starting time is 15
minutes.

7. Click Start.

Data is shown in panes below the Tune Method Editor.

8. Note the signal of the peak of interest.

9. In the Curtain Gas (CUR) field, increase the value by five.

10. Continue increasing the Curtain Gas (CUR)  value until the highest value without losing sensitivity is found.

As with most Source/Gas parameters, if two values give the same result, then use the higher value.

11. Repeat this procedure for the other Source/Gas parameters.

When optimizing for these parameters, look for the value that gives the highest signal-to-noise value.

Advanced Parameters
The following parameters should only be optimized by an experienced operator.

Optimize AF2
The AF2 parameter controls the fragmentation of the second precursor ion in an MS3 scan. The amount of excitation
energy used depends on the compound and the desired amount of fragmentation.
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1. For both positive and negative ion modes, ramp AF2 from 0.07 V to 0.3 V, with a step value of 0.01 V.

The allowable range is 0 V to 1 V.

2. For both positive and negative ion modes, ramp AF2 from 0 mV to 200 mV with a step value of 5 mV.

3. Select the AF2 value that gives the best amount of fragmentation.

If the MS3 scan is selected when using the 6500 and 6500+ series of instruments, the No Fragmentation
option is not available. However, users can achieve the effect of the No Fragmentation option by setting the
AF2 parameter to 0 on the Compound tab of the Tune Method Editor.

About Collision Energy Spread (CES)
Under the compound-dependent parameters in Enhanced Product Ion (EPI) and MS3 experiments, the collision
energy spread (CES) field allows users to specify the difference in collision energies that will be applied in the
experiment. For example, if CE value of 30 and a CES value of 15 are used, then collision energies of 15, 30, and
45 are used.
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The first number under each scan type is the preset value. The range of numbers is the accessible range for each
parameter.

Table B-1 System Parameters

Negative Ion ModePositive Ion ModeAccess IDParameter
ID MS/MSQ3Q1MS/MSQ3Q1

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

CURCUR

Med (9

0 to 12

5

N/A

0

N/A

Med (9)

0 to 12

6

N/A

0

N/A

CADCAD

–4500

–4500 to 0

–4500

–4500 to 0

–4500

–4500 to 0

5500

0 to 5500

5500

0 to 5500

5500

0 to 5500

IS1,2IS1,2

–3

–5 to 0

–3

–5 to 0

–3

–5 to 0

3

0 to 5

3

0 to 5

3

0 to 5

NC3NC3

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

TEM2,3TEM2,3

–100

–300 to 0

–100

–300 to 0

–100

–300 to 0

100

0 to 300

100

0 to 300

100

0 to 300

DPOR

(DP = OR)

–10

–15 to –2

–10

–15 to –2

–10

–15 to –2

10

2 to 15

10

2 to 15

10

2 to 15

EPQ0

(EP = –Q0)

Q0 + 0.5

0.1 to 2

Q0 + 0.5

0.1 to 2

Q0 + 0.5

0.1 to 2

Q0 +
(–0.5)

–0.1 to –2

Q0 +
(–0.5)

–0.1 to –2

Q0 + (–0.5)

–0.1 to –2

IQ1IQ1

(IQ1 = Q0 +
offset)

1 Turbo VTM ion source

2 TurboIonSpray
®
 probe

3 APCI probe
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Table B-1 System Parameters (continued)

Negative Ion ModePositive Ion ModeAccess IDParameter
ID MS/MSQ3Q1MS/MSQ3Q1

Q0 + 8

12 to 5

Q0 + 8

12 to 5

Q0 + 8

12 to 5

Q0 + (-8)

-12 to –5

Q0 + (-8)

–12 to –5

Q0 + (-8)

–12 to –5

STST

(ST = Q0 +
offset)

–1
–3 to –0

N/A–1
–3 to –0

1
0 to 3

N/A1
0 to 3

IE1RO1
(IE1 = Q0 –
RO1)

Q0 + 10

8 to 30

Q0 + 10

8 to 30

Q0 + 10

8 to 30

Q0+ (–10)

–30 to –8

Q0+ (–10)

–30 to –8

Q0+ (–10)

–30 to –8

IQ2IQ2
(IQ2 = Q0 +
offset)

N/A20

N/A

20

N/A

N/A–20

N/A

–20

N/A

RO2RO2

–30

–180 to

–5

N/AN/A30

5 to 180

N/AN/ACERO2

(CE = Q0 –
RO2)

N/AN/ARO2 + 10

5 to 30

N/AN/ARO2 – 10

–30 to –5

ST3ST3

(ST3 = RO2 +
offset)

–15

–55 to 0

–15

–55 to 0

N/A15

0 to 55

15

0 to 55

N/ACXPST3

(CXP = RO2 –
ST3)

N/AN/A50

N/A

N/AN/A–50

N/A

RO3RO3

–1

–5 to 0

–1

–5 to 0

N/A1

0 to 5

1

0 to 5

N/AIE3RO3

(IE3 = RO2 –
RO3)

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

CEMCEM
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Table B-1 System Parameters (continued)

Negative Ion ModePositive Ion ModeAccess IDParameter
ID MS/MSQ3Q1MS/MSQ3Q1

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

GS1GS1

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

GS2GS2

Table B-2 LIT Scan Type Parameters (If Enabled)

Note: Linear ion trap scan types are only available on QTRAP
®
-enabled systems.

Negative Ion ModePositive Ion ModeAccess IDParameter ID

High

Low–High

High

Low–High

CADCAD

0.100

0 or 1

0.100

0 or 1

AF2AF24

Mass-Speed Dependent

0 to 10

Mass-Speed Dependent

0 to 10

AF3AF3

Mass-Speed Dependent

0 to 165

Mass-Speed Dependent

–165 to 0

EXBEXB

0

0 to 50

0

0 to 50

CESCES

–10

–5 to –180

10

5 to 180

CEROS

(Q0 - ROS)

4 MS/MS/MS only
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CAUTION: Potential Wrong Result. Do not use expired solutions.

Table C-1 Tuning Frequency

Resolution OptimizationCalibration

Manual/AutomatedFrequencyManual/AutomatedFrequencyScan Type

Both3 months to 6 monthsBoth3 months to 6 monthsQ1 and Q3

Automated only3 months to 6 monthsBothEvery 2 weeks, as requiredLIT

Table C-2 Suggested Tuning Solutions

LITQ1 and Q3System

Positive and NegativeNegativePositive

N/ANEG PPG, 3e-5 MPOS PPG, 2e-7 MTriple quadrupole LC-MS/MS system

Agilent ESI Tuning MixNEG PPG, 3e-5 MPOS PPG, 2e-7 MLinear ion trap LC-MS/MS system
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Table C-3 Q1 and Q3 PPG Ion Scans

MassesPolarity

1196.881080.80906.67616.46175.1359.05Positive

N/A1572.101223.85933.64585.3945.00Negative

Table C-4 LIT Scans (Agilent)

MassesPolarity

922.01622.03322.05118.09Positive

N/A601.98431.98112.99Negative
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For additional toolbar icons, refer to the Advanced User Guide.

Table D-1 Tool Bar Icons

DescriptionNameIcon

Creates a subproject. Subprojects can only be created later in the process
if the project was originally created with subprojects.

New Subproject

Copies a Subproject folder.

Subprojects can be copied only from another project that has existing
subprojects. If the same folders exist at both the project and subproject levels,
then the software uses the project level folders.

Copy Subproject

Table D-2 Acquisition Method Editor Icons

DescriptionNameIcon

Click to show the MS tab in the Acquisition Method editor.Mass Spec

Right-click to add an experiment, add an IDA Criteria Level, or delete the
period.

Period

Click to open the Autosampler Properties tab.Autosampler

Click to open the Syringe Pump Properties tab.Syringe Pump

Click to open the Column Oven Properties tab.Column Oven

Click to open the Valve Properties tab.Valve

Click to open the DAD Method Editor. Refer to Generate DAD Data.DAD

Click to open the ADC Properties tab. Refer to Show ADC Data.ADC
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Table D-3 Acquire Mode Icons

DescriptionNameIcon

Shows the sample queue.View Queue

Shows a remote instrument station.Instrument Queue

Shows the status of a remote instrument.Status for Remote
Instrument

Starts the sample in the queue.Start Sample

Stops the sample in the queue.Stop Sample

Aborts a sample acquisition in the middle of the processing of that sample.Abort Sample

Stops the queue before it has completed processing all the samples.Stop Queue

Inserts a pause in the queue.Pause Sample
Now

Inserts a pause before a specific sample.Insert Pause
before Selected
Sample(s)

Continues acquiring the sample.Continue Sample

Starts a new period.Next Period

Extends the current period.Extend Period

Stops acquiring the current sample and starts acquiring the next sample.Next Sample

Selects the method to be used to equilibrate the devices. This method should
be the same as the method used with the first sample in the queue.

Equilibrate

Puts the instrument in Standby mode.Standby

Puts the instrument in Ready mode.Ready
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Table D-3 Acquire Mode Icons (continued)

DescriptionNameIcon

Reserves the mass spectrometer for tuning and calibrating.Reserve
Instrument for
Tuning

Starts the IDA Method Wizard.IDA Method
Wizard

Starts the modifier purge from the modifier pump.Purge Modifier

Table D-4 Tune and Calibrate Mode Icons

DescriptionNameIcon

Opens the Mass Calibration Option dialog and uses the active spectrum to
calibrate the mass spectrometer.

Calibrate from
spectrum

Opens the Manual Tune Editor.Manual Tune

Optimizes for a compound using infusion by FIA.Compound
Optimization

Verifies the instrument performance, adjusts the mass calibration, or adjusts
mass spectrometer settings.

Instrument
Optimization

Views the sample queue.View Queue

Views a remote instrument.Instrument Queue

Views the status of a remote instrument.Status for Remote
Instrument

Reserves the instrument for tuning and calibrating.Reserve
Instrument for
Tuning

Starts the IDA Method Wizard.IDA Method
Wizard
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Table D-5 Explore Quick Reference: Chromatograms and Spectrum

DescriptionNameIcon

Opens files.Open Data File

Goes to the next sample.Show Next Sample

Goes to the previous sample.Show Previous
Sample

Opens the Select Sample dialog.Go To Sample

Views the data in tables.List Data

Generates a TIC from a spectrum.Show TIC

Extracts ions by selecting masses.Extract Using
Dialog

Generates a BPC.Show Base Peak
Chromatogram

Generates a spectrum from a TIC.Show Spectrum

Copies the active graph to a new window.Copy Graph to
new Window

Opens the Baseline Subtract dialog.Baseline Subtract

Adjusts the threshold.Threshold

Shows the Noise Filter Options dialog, which can be used define the minimum
width of a peak. Signals below this minimum width are regarded as noise.

Noise Filter

Shows ADC data.Show ADC

Shows the experimental conditions used to collect the data.Show File Info

Adds arrows to the X-axis of the active graph.Add arrows

Removes arrows from the X-axis of the active graph.Remove all arrows

Compensates for slight differences in the time during which the ADC data and
the mass spectrometer data were recorded. This is useful when overlaying
graphs for comparison.

Offset Graph
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Table D-5 Explore Quick Reference: Chromatograms and Spectrum (continued)

DescriptionNameIcon

Labels all of the peaks.Force Peak Labels

Sets the expansion factor for a portion of a graph to be viewed in greater
detail.

Expand Selection
By

Returns the expanded selection to normal view.Clear ranges

Defines start and stop points for a selection. This feature provides more accurate
selection than is possible by selecting the region using the cursor.

Set Selection

Scales a graph to maximum size, so that the most intense peak is scaled to
full scale, whether or not it is visible.

Normalize To Max

Shows a summary of data processing operations performed on a particular
file, such as smoothing, subtraction, calibration, and noise filtering.

Show History

Opens the compound database.Open Compound
Database

Adjusts the threshold.Set Threshold

Shows selected data as either a spectrum graph or an XIC. Additionally, for
data acquired by a DAD, a contour plot can show selected data as either a
DAD spectrum or an XWC.

Show Contour Plot

Generates a TWC of the DAD spectrum.Show DAD TWC

Generates a DAD spectrum.Show DAD
Spectrum

Extracts up to three wavelength ranges from a DAD spectrum to view the XWC.Extract
Wavelength

Table D-6 Explore Toolbar Quick Reference: Overlaying Graphs

DescriptionNameIcon

Click to return the graph to the original scale.Home Graph

Click to overlay graphs.Overlay
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Table D-6 Explore Toolbar Quick Reference: Overlaying Graphs (continued)

DescriptionNameIcon

Click to cycle between overlaid graphs.Cycle Overlays

Click to add the graphs together.Sum Overlays

Table D-7 Explore Toolbar Quick Reference: Fragment Interpretation Tool

DescriptionNameIcon

Click to open Fragment Interpretation tool, which calculates the single,
non-cyclic bond cleavage fragments from a .mol file.

Show Fragment
Interpretation Tool

Table D-8 Navigation Icons on the Explore Toolbar

FunctionNameIcon

Click to open files.Open File

Click to navigate to the next sample.Show Next Sample

Click to navigate to the previous sample.Show Previous
Sample

Click to open the Select Sample dialog.GoTo Sample

Click to view the data in tables.List Data

Click to generate a TIC from a spectrum.Show TIC

Click to extract ions by selecting masses.Extract Using
Dialog

Click to generate a BPC.Show Base Peak
Chromatogram

Click to generate a spectrum from a TIC.Show Spectrum

Click to copy the active graph to a new window.Copy Graph to
new Window

Click to open the Baseline Subtract dialog.Baseline Subtract
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Table D-8 Navigation Icons on the Explore Toolbar (continued)

FunctionNameIcon

Click to adjust the threshold.Threshold

Click to use the Noise Filter Options dialog to define the minimum width of a
peak. Signals below this minimum width are regarded as noise.

Noise Filter

Click to view ADC data.Show ADC

Click to show the experimental conditions you used to collect your data.Show File Info

Click to add arrows to the x-axis of the active graph.Add arrows

Click to remove arrows from the x-axis of the active graph.Remove all arrows

Click to compensate for slight differences in the time during which the ADC
data and the mass spectrometer data were recorded. This is useful when
overlaying graphs for comparison.

Offset Graph

Click to label all the peaks.Force Peak Labels

Click to set the expansion factor for a portion of a graph that you want to view
in greater detail.

Expand Selection
By

Click to return the expanded selection to normal view.Clear ranges

Click to type start and stop points for a selection. This provides more accurate
selection than is possible by highlighting the region using the cursor.

Set Selection

Click to scale a graph to maximum, so that the most intense peak is scaled is
to full scale, whether or not it is visible.

Normalize to Max

Click to view a summary of data processing operations performed on a
particular file, such as smoothing, subtraction, calibration, and noise filtering.

Show History

Click to open the compound database.Open Compound
Database

Click to adjust the threshold.Set Threshold

Click to display selected data as either a spectrum graph or an XIC. Additionally,
for data acquired by a DAD, a contour plot can display selected data as either
a DAD spectrum or an XWC.

Show Contour Plot

Click to generate a TWC of the DAD.Show DAD TWC
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Table D-8 Navigation Icons on the Explore Toolbar (continued)

FunctionNameIcon

Click to generate a DAD spectrum.Show DAD
Spectrum

Click to extract up to three wavelength ranges from a DAD spectrum to view
the XWC.

Extract
Wavelength

Table D-9 Integration Tab and Quantitation Wizard Icons

DescriptionNameIcon

Uses the selected peak.Set parameters from
Background Region

Uses the selected background.Select Peak

Manually integrates peaks.Manual Integration Mode

Toggles the peak-finding parameters between shown and hidden.Show or Hide Parameters

Shows the analyte chromatogram only.Show Active Graph

Shows the analyte and its associated chromatogram (available only
when an associated internal standard exists).

Show Both Analyte and IS

Returns to the preset (view all data) view (if, for example, the user
has zoomed in on a chromatogram).

Use Default View for Graph

Table D-10 Results Table Icons

DescriptionNameIcon

Sorts the selected column by ascending values.Sort Ascending by Selection

Sorts the selected column by descending values.Sort Descending by
selection

Locks or unlocks the selected column. A locked column cannot be
moved.

Lock Or Unlock Column

Creates a metric plot from the selected column.Metric Plot By Selection
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Table D-10 Results Table Icons (continued)

DescriptionNameIcon

Shows all the samples in the Results Table.Show all Samples

Deletes formula columns.Delete Formula Column

Opens the Reporter software.Report Generator

Table D-11 Icon Quick Reference: Quantitate Mode

DescriptionNameIcon

Adds or removes samples from the Results Table.Add/Remove Samples

Saves the Results Table as a text file.Export as Text

Opens a wiff file.Modify Method

Opens peaks in a pane.Peak Review - Pane

Opens peaks in a window.Peak Review - Window

Opens the calibration curve in a pane.Calibration - Pane

Opens the calibration curve in a window.Calibration - Window

Shows the first peak in the pane or window.Show First Peak

Shows the last peak in the pane or window.Show Last Peak

Shows the audit trail for the Results Table.Show Audit Trail

Clears the audit trail for the Results Table. This functionality is not
available.

Clear Audit Trail

Opens the Statistics window.Statistics

Opens the Reporter software.Report Generator
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Note: Not all of the symbols in the following table are applicable to every instrument.

DescriptionSymbol

Australian Regulatory Compliance Mark. Indicates the products complies with Australian
Communications Media Authority (ACMA) EMC Requirements.

Alternating current

Amperes (current)A

Authorized representative in the European community

Biohazard

CE Marking of Conformity

cCSAus mark. Indicates electrical safety certification for Canada and USA.

Catalogue number

Caution

Note: In SCIEX documentation, this symbol identifies a personal injury hazard.
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DescriptionSymbol

China RoHS Caution Label. The electronic information product contains certain toxic or
hazardous substances. The center number is the Environmentally Friendly Use Period
(EFUP) date, and indicates the number of calendar years the product can be in operation.
Upon the expiration of the EFUP, the product must be immediately recycled. The circling
arrows indicate the product is recyclable. The date code on the label or product indicates
the date of manufacture.

China RoHS logo. The device does not contain toxic and hazardous substances or elements
above the maximum concentration values, and it is an environmentally-friendly product
that can be recycled and reused.

Consult instructions for use.

cTUVus mark for TUV Rheinland of North America.

Data Matrix symbol that can be scanned by a barcode reader to obtain a unique device
identifier (UDI).

Environmental Hazard

Ethernet connection

Explosion Hazard

Fire Hazard

Flammable Chemical Hazard
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DescriptionSymbol

Fragile

Fuse

HertzHz

High Voltage. Electrical Shock Hazard
If the main cover must be removed, contact a SCIEX representative to prevent electric
shock.

Hot Surface Hazard

In Vitro Diagnostic Device

Ionizing Radiation Hazard

Keep dry.

Do not expose to rain.

Relative humidity must not exceed 99%.

Keep upright.

Lacerate/Sever Hazard

Laser Radiation Hazard

Lifting Hazard
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DescriptionSymbol

Manufacturer

Moving Parts Hazard

Pinch Hazard

Pressurized Gas Hazard

Protective Earth (ground)

Puncture Hazard

Reactive Chemical Hazard

Serial number

Toxic Chemical Hazard

Transport and store the system within 66 kPa to 103 kPa.

Transport and store the system within 75 kPa to 101 kPa.

Transport and store the system within 10% to 90% relative humidity.
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DescriptionSymbol

Transport and store the system within –30 °C to +45 °C.

Transport and store the system within –30 °C to +60 °C.

USB 2.0 connection

USB 3.0 connection

Ultraviolet Radiation Hazard

Volt Ampere (power)VA

Volts (voltage)V

WEEE. Do not dispose of equipment as unsorted municipal waste. Environmental Hazard

WattsW

yyyy-mm-dd
Date of manufacture
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Note: If any of the labels used to identify a component become detached, contact an FSE.

Translation (if applicable)Label

FOR RESEARCH USE ONLY. NOT FOR USE IN
DIAGNOSTIC PROCEDURES.

FOR RESEARCH USE ONLY. NOT FOR USE IN
DIAGNOSTIC PROCEDURES.

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

Note: If the indicator is tripped, then this container
has been dropped or otherwise mishandled. Make a
note on the Bill of Lading and then check for damage.
Any claims for shock damage require a notation.

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE INCLUDING
TRIPPED “IMPACT INDICATOR” OR “TILT INDICATOR”
ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND
NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT
ENGINEER IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER
SUPPORT ENGINEER FOR UNCRATING AND
INSTALLATION.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE INCLUDING
TRIPPED “IMPACT INDICATOR” OR “TILT INDICATOR”
ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND
NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT
ENGINEER IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER
SUPPORT ENGINEER FOR UNCRATING AND
INSTALLATION.

MINIMUM OF SIX PERSONS REQUIRED TO SAFELY LIFT
THIS EQUIPMENT

MINIMUM OF SIX PERSONS REQUIRED TO SAFELY LIFT
THIS EQUIPMENT

Tilt Indicator

Note: Indicates whether the container was tipped or
mishandled. Write on the Bill of Lading and inspect
for damage. Any claims for tipping require a notation.

TIP & TELL
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Translation (if applicable)Label

Tilt Indicator

Note: Indicates whether the container was tipped or
mishandled. Write on the Bill of Lading and inspect
for damage. Any claims for tipping require a notation.

TiltWatch PLUS

ShockWatch

WARNING: DO NOT OPERATE WITHOUT FIRST
ENSURING BOTTLE CAP IS SECURED.

Note: This warning is attached to the source exhaust
waste bottle.

WARNING: DO NOT OPERATE WITHOUT FIRST
ENSURING BOTTLE CAP IS SECURED.

WARNING: NO USER SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED PERSONNEL.

Note: Consult instructions for use.

WARNING: NO USER SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED PERSONNEL.
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Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEXUniversity

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout
the world. They can answer questions about the system or any technical issues that might arise. For more
information, visit the SCIEX website at sciex.com or contact us in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest version, go to
https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide that comes with
the software. Documentation for the hardware products can be found on the Customer Reference DVD that
comes with the system or component.

For the latest versions of the documentation, visit the SCIEX website at sciex.com.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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